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About this Guide

This guide provides upgrade instructions for Software AG products.

Document Conventions

Convention Description

Bold Identifies elements on a screen.

Narrowfont Identifies service names and locations in the format
folder.subfolder.service , APIs, Java classes, methods, properties.

Italic Identifies:

Variables for which you must supply values specific to your own
situation or environment.
New terms the first time they occur in the text.
References to other documentation sources.

Monospace
font

Identifies:

Text you must type in.
Messages displayed by the system.
Program code.

{ } Indicates a set of choices from which you must choose one. Type
only the information inside the curly braces. Do not type the { }
symbols.

| Separates two mutually exclusive choices in a syntax line. Type
one of these choices. Do not type the | symbol.

[ ] Indicates one or more options. Type only the information inside
the square brackets. Do not type the [ ] symbols.

... Indicates that you can type multiple options of the same type.
Type only the information. Do not type the ellipsis (...).
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Online Information and Support
Software AG Documentation Website

You can find documentation on the Software AG Documentation website at “hp://
documentation.softwareag.com”. The site requires credentials for Software AG's Product
Support site Empower. If you do not have Empower credentials, you must use the
TECHcommunity website.

Software AG Empower Product Support Website

If you do not yet have an account for Empower, send an email to
“empower@softwareag.com” with your name, company, and company email address
and request an account.

Once you have an account, you can open Support Incidents online via the eService
section of Empower at “hps://empower.softwareag.com/”.

You can find product information on the Software AG Empower Product Support
website at “hps://empower.softwareag.com”.

To submit feature/enhancement requests, get information about product availability,
and download products, go to “Products”.

To get information about fixes and to read early warnings, technical papers, and
knowledge base articles, go to the “Knowledge Center”.

If you have any questions, you can find a local or toll-free number for your country
in our Global Support Contact Directory at “hps://empower.softwareag.com/
public_directory.asp” and give us a call.

Software AG TECHcommunity

You can find documentation and other technical information on the Software AG
TECHcommunity website at “hp://techcommunity.softwareag.com”. You can:

Access product documentation, if you have TECHcommunity credentials. If you do
not, you will need to register and specify "Documentation" as an area of interest.

Access articles, code samples, demos, and tutorials.

Use the online discussion forums, moderated by Software AG professionals, to
ask questions, discuss best practices, and learn how other customers are using
Software AG technology.

Link to external websites that discuss open standards and web technology.

http://documentation.softwareag.com
http://documentation.softwareag.com
mailto:empower@softwareag.com
https://empower.softwareag.com/
https://empower.softwareag.com
https://empower.softwareag.com/Products/default.asp
https://empower.softwareag.com/KnowledgeCenter/default.asp
https://empower.softwareag.com/public_directory.asp
https://empower.softwareag.com/public_directory.asp
http://techcommunity.softwareag.com
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Data Protection
Software AG products provide functionality with respect to processing of personal data
according to the EU General Data Protection Regulation (GDPR). Where applicable,
appropriate steps are documented in the respective administration documentation.
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Using Command Central to Upgrade Products
If you want to upgrade products in one environment using Command Central, follow
the instructions in this guide.

If you want to fully automate product upgrade for multiple similar environments using
Command Central, see the composite template instructions in Software AG Command
Central Help. You can reconfigure endpoints such as host names and ports by adding
commands after the migration section of the templates. You will still need to perform the
manual tasks in this guide if you cannot script them.

To see which products support upgrade/migration using Command Central, see
Software AG Command Central Feature Support Matrix.

Note: You do not have to upgrade Platform Manager.

Command Central supports the upgrade scenarios below.

Same Installation Directory, Hosts, and Ports; Live Database
Command Central renames the old product installation directory, then uses the old
directory name for the new product installation.

Benefits: Simple; similar to overinstall in that all paths, hosts, and ports remain the same.
Can fully automate using custom composite templates.

Cautions: Risky; rollback is complicated. Significant downtime. Must back up live
databases; use of cloned databases is not supported. Requires double disk space because
old installation is still present. Requires extensive automated testing before production
environments can be migrated.

New Installation Directory, Same Hosts and Ports, Cloned Database
Benefits: New installation is almost identical to old. Safer than first scenario; rollback is
much simpler. Can start old installation after shuing down new installation, and vice
versa. Can fully automate using custom composite templates or can perform step by step
using a combination of the Command Central web user interface and commands.

Cautions: Requires double disk space because old installation is still present. Must adjust
third-party tooling to point to new installation directory.

New Installation Directory and Ports, Same Hosts, Cloned Database
Benefits: Safer than first scenario; rollback is much simpler. Downtime is less than first
and second scenarios; can migrate gradually while old installation continues to operate.
Can fully automate using custom composite templates.
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Cautions: Preparation for migration is more complex than first and second scenarios.
Requires double disk space because old installation is still present. Must change
endpoints to reflect new ports. Must adjust third-party tooling to new installation.

New Hosts, Live or Cloned Database
Typically required because of upgrades to hardware and operating systems. Use of
same installation directory and ports can minimize change. Use of DNS to control IP-to-
host mapping for the old and new environment can greatly simplify impact on external
clients.

Benefits: Safest scenario, and minimal downtime. Easiest scenario when environment
runs in a private or public cloud that allows temporary increase of capacity to host new
environment and then release resources used by old environment. Can phase migration.
Must adjust third-party tooling to new installation. Can fully automate using custom
composite templates or can perform step by step using a combination of the Command
Central web user interface and commands.

Cautions: Some products allow cross-operating system migration, but for other
products, this type of migration might have unpredictable results, especially when old
machine is Windows and new machine is non-Windows, or vice versa.

Using Software AG Installer, Software AG Update Manager,
and Software AG Migration Utilities to Upgrade Products
If you want to upgrade using Software AG Installer to install new products; Software
AG Update Manager to install fixes; and Software AG migration utilities to migrate
product configurations, data, and assets, follow the instructions in this guide.
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Upgrades Covered in This Guide
This guide explains how to upgrade the following from 9.7, 9.8, 9.9, 9.10, 9.12, 10.1, and
10.2 to 10.3:

Apama, MashZone NextGen, Universal Messaging, and webMethods products.

Terracoa and Zementis Predictive Analytics when used with webMethods
products.

You can also use the procedures in this guide to migrate data from one 10.3 installation
to another 10.3 installation (for example, for a data center move).

Support for Upgrade Across Operating Systems
Integration Server, Microservices Runtime, OneData, and Universal Messaging support
migration across machines that have the same operating system and across machines
that have different operating systems.

The other products support migration from a Windows system to another Windows
system, and from a UNIX system to another UNIX system when both systems are
using a JVM from the same vendor. These products do not support migration from one
operating system to a different operating system (for example, from a Windows system
to a UNIX system, or vice versa).

Release Numbering Exceptions
The products below did not follow general release numbering.

In the webMethods 9.9, 9.10, and 9.12 releases, ActiveTransfer remained at its 9.8
release.

In the webMethods 9.7, 9.8, 9.9, 9.10, 9.12, 10.1, 10.2, and 10.3 releases, the Terracoa
release numbers were 4.1.4, 4.3, 4.3.1, 4.3.2, 4.3.3, 4.3.4, 4.3.5, and 4.3.6, respectively.

Documentation Needed to Perform the Upgrade
You will need the documentation listed below to perform the upgrade.

Release notes for the old release + 1 through the new release; these list new features.

Product readmes for the new release; these describe changes to product behavior;
deprecations, removals, and additions of services, APIs, and other items; critical
information about the new product release; and known and resolved issues.
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Fix readmes for fixes you install on new products; these list resolved issues and
changes in behavior.

System Requirements for Software AG Products

Supported Upgrade Paths for Software AG Products

Software AG Command Central Help or Using Software AG Installer

Installing Software AG Products

Using Software AG Update Manager (latest release)

You might need the documentation listed below to perform this upgrade, depending on
the products you are upgrading. The release of the documentation you need is the new
release.

webMethods API Portal Administrator’s Guide and webMethods API Portal Customization
Guide

webMethods Application Platform User’s Guide

webMethods BPM Task Development Help

CentraSite documentation

webMethods Deployer User’s Guide

webMethods Integration Server Administrator’s Guide, webMethods Service Development
Help, and webMethods Integration Server Clustering Guide

MashZone NextGen Administration Guide and MashZone NextGen User and Developer
Guide

Administering My webMethods Server

Administering webMethods OneData

Administering webMethods Optimize and Configuring BAM

Using Terracoa with webMethods Products and Terracoa BigMemory Max
documentation

Universal Messaging

Upgrades Not Covered in This Guide
The table below lists upgrades that are not covered in this guide, and supplies the
correct information source.

Upgrade Information

From a release prior to 9.7 See Supported Upgrade Paths
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Upgrade Information

Apama releases prior to
9.9

See the Apama release notes for the pre-9.9 release

ApplinX See ApplinX documentation

webMethods Broker to
Universal Messaging

webMethods Broker has been deprecated. You can
migrate from webMethods Broker 9.6 to Universal
Messaging10.3; to plan the migration, see Migrating
from webMethods Broker to webMethods Universal
Messaging. During the migration you can continue
to use webMethods Broker 9.6 and Universal
Messaging 10.3 with the same Integration Server
10.3.

Command Central See Software AG Command Central Help

Presto and MashZone
NextGen

There is no direct path from Presto 3.8
(webMethods release 9.7), Presto 3.9 (webMethods
release 9.8), or MashZone NextGen 9.9 to
MashZone NextGen 10.3. Instead, you must
upgrade to MashZone NextGen 9.10 using the
instructions in the 9.10 upgrade guide, and then
upgrade from 9.10 to MashZone NextGen 10.3
using the instructions in this guide.

Terracoa when not
used with webMethods
products

See Terracoa BigMemory Max documentation

Terracoa BigMemory
Max to Terracoa DB

Terracoa DB 10.3 is significantly different from
Terracoa BigMemory Max 4.x and 3.7.6 in terms of
handling of cluster topology, data storage formats,
and other functionality. You cannot migrate data
and configuration for a Terracoa BigMemory Max
server to a Terracoa DB server.

Zementis Predictive
Analytics when not
used with webMethods
products, and releases
prior to 10.1

See the Zementis installation guide for the release
from which you want to upgrade.
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Preparation and Planning
Software AG strongly recommends that you plan and prepare for your upgrade before
performing the procedure described in this guide. Planning and preparing can include
the tasks listed below.

Read this guide in its entirety so you are familiar with all tasks you will need to
perform.

Read the product release notes. The release notes provide information on new
functionality. Read the information for every release for your old release + 1 through
the new release.

Read the product readmes for the new release, including the readme for the Software
AG Infrastructure. All readmes are available on the Software AG Documentation
website. The product readmes contain this information:

Critical information and known and resolved issues for your products.

Changes to product behavior, services, parameters, properties, and APIs. Such
changes can include additions, changes, deprecations, and removals. This
information is especially important because you might need to modify product
files or assets after migration to accommodate the changes.

Read the information in product readmes for your old release+1 through the new
release. For example, if you are upgrading from 9.8 to 10.3, read the information for
releases 9.9 through 10.3.

Go to the “Knowledge Center” on the Empower Product Support Website and read
tech articles (for example, KB 1788395). Use keywords such as upgrade to search
for relevant tech articles, and search for your old release, your new release, and all
releases in between.

Define an upgrade approach and a cut-over plan. If you have a large landscape, you
might want to do a phased upgrade.

Set up operating guidelines that cover normal project management requirements
across all affected groups in your organization.

Define an approach to source control, and set up release management tools and
procedures that support the migration of data into target environments.

Account for externals to your Software AG environment, such as clients that
communicate with your Software AG products and that might need endpoint URL,
host name, or IP address updates.

As part of upgrading, you will take a baseline of the old environment and use that
baseline to perform the upgrade procedure. Software AG recommends a code freeze
while you are migrating the baseline to the new environment.

Many upgrade issues are caused by forgoen environmental seings. Plan,
document, and test these thoroughly.

https://empower.softwareag.com/KnowledgeCenter/default.asp
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For complex projects that require extensive system testing, extended code freeze
might not be possible. In this case, define a change management strategy to track
code changes that occur in the old environment. After testing is complete on the
baseline, this will enable you to merge the code changes into the baseline and re-test
the new baseline.

If you need help creating your planning approach, contact Software AG Global
Consulting Services. You can also go to the “Software AG TECHcommunity” and
find tips and tricks and other information in the upgrade wiki (Wiki > webMethods >
Upgrade).

Testing and Troubleshooting
Testing can include the tasks listed below.

Software AG strongly recommends that you upgrade in a controlled test
environment and test that environment for proper operation before promoting to
your production environment.

Provision new environments to support the upgrade. Environments in which you
conduct testing should mirror the production environment.

Obtain test data from the source environment and establish baseline test results.

Many upgrade issues are caused by forgoen environmental seings. Plan,
document, and test these thoroughly.

Identify test tools for unit, functional, and non-functional regression testing.

Define acceptance and sign off criteria.

Automate a core set of regression tests for the upgrade. Software AG recommends
focusing your tests most heavily on product areas that have undergone the most
change. The readmes and release notes provide all product change information (see
“Preparation and Planning” on page 22 for details).

If upgrading to new machines, make sure connections and firewalls are open to
back-end systems before starting any system testing.

Use an issue management system to track defects and issues.

If code freeze of the old environment during test is not possible, merge code changes
from the old environment into the baseline and re-test the new baseline.

If you need help creating your testing approach, contact Software AG Global Consulting
Services.

If you encounter errors during the upgrade, try the troubleshooting methods below.

Look in log files.

The table below lists the types of logs that record upgrade information and their
locations.

http://techcommunity.softwareag.com/
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Type of Log Location

Installation and
uninstallation

new_Software AG_directory /install/logs directory

Product In a logs directory in the product file structure, or in the
new_Software AG_directory /profiles/product /logs directory.

Data migration new_Software AG_directory /install/logs directory and product
directories indicated by the upgrade procedures

Database
migration

new_Software AG_directory /common/db/logs directory.

Go to the “Knowledge Center” on the Empower Product Support Website and read
tech articles (for example, KB 1788395). Use keywords such as upgrade to search
for relevant tech articles, and search for your old release, your new release, and all
releases in between.

Go to the “Software AG TECHcommunity” and:

Join the upgrade discussion forum (Forums > webMethods > Upgrade).

Read and share tips and tricks and other information in the upgrade wiki (Wiki >
webMethods > Upgrade).

If you cannot resolve the problem using the methods above, contact Software AG Global
Support.

General Upgrade Procedure Requirements

Important: If you do not conform to these requirements, you will experience
unpredictable results, possibly including corruption of your installation and
data.

Perform the tasks in the upgrade documentation in the exact order in which they
are presented. The task order is critical because your products have many inter-
dependencies, including shared infrastructure and event driven architecture.

After you install the new products, you install the latest fixes. However, the upgrade
procedure might take days or weeks to complete. Continue to check for and install
new fixes regularly during the procedure.

Do not start any new products before the instructions in this guide tell you to do so,
or your database components could become corrupted.

https://empower.softwareag.com/KnowledgeCenter/default.asp
http://techcommunity.softwareag.com/
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Perform the tasks in this guide for all upgrade paths unless the guide states that a
particular task is required for certain upgrade paths only.

This guide assumes you are using the same RDBMS in the new environment that
you used in the old environment. If you want to use a different RDBMS in the
new environment, there are special requirements that must be met before you can
upgrade your products. Contact Software AG Global Consulting Services for more
information.

API Gateway

Note: Event Data Store was renamed Internal Data Store in release 10.2.

API Gateway supports many operating systems. However, API Gateway depends
on Internal Data Store, which supports only Windows and Red Hat Enterprise Linux
operating systems. You might therefore want to install two new API Gateways: One that
will host migrated API Gateway assets, and one that will host the Internal Data Store
with migrated Event Data Store data.

API Portal Requirements
You must have these functional privileges to upgrade API Portal:

License, user, and document management

User management configuration

Database administration

Ask your API Portal administrator to log on to the User Management Component at
hp://host :port /umc, go to the user management page, click your user name, and either
add you to the API Administrator group or go to the Functional Privileges tab and
assign the privileges listed above to you.

CentraSite Requirements
If you want to install the CentraSite Application Server Tier and CentraSite Registry
Repository on different machines, or in the same directory but at different times, you
must install the Registry Repository first.

Software AG Designer Requirements
If you are upgrading products involving Software AG Designer projects, make sure
the target machine has enough space for the projects you will migrate (see “Migrate
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Software AG Designer, Business Process Runtime Data, and Closed Loop Analytics” on
page 79).

Integration Server or Microservices Runtime Requirements

Note: Steps for Microservices Runtime are identical to those for Integration Server.

General Requirements
Make sure the target machine has enough space for custom packages you will migrate.
Custom packages include packages created by users in Software AG Designer and
business process packages generated by users from Software AG Designer.

Clustering Requirements
In Integration Server, a cluster is defined as multiple Integration Server instances
that point to the same ISInternal database component and connect to the same Cache
Manager on a Terracoa Server Array. A cluster can include Integration Server
installations on different machines, server instances within an Integration Server
installation, or both.

This section is intended for use with the rest of the upgrade procedure. You must
perform all documented tasks for your products in the order they are wrien, with the
additional tasks or exceptions noted below.

When you install the new Integration Servers, create a cluster that matches your old
cluster. You can install the new Integration Servers in parallel.

When you install the fixes on the new Integration Servers, you can install the fixes in
parallel.

When you shut down the old products, shut down all cluster nodes.

Configure the cluster as instructed in webMethods Integration Server Clustering Guide.

My webMethods Server Requirements

Environment Variable
In your old release, you might have identified a default My webMethods Server
installation in the global path of the installation’s host machine using the environment
variable WM_HOME. If you are going to install the new release on the same machine as
the old release, the existence of this variable could cause problems, so you must remove
the environment variable from the global path.
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Do not redefine the environment variable after installing the new My webMethods
Server.

My webMethods Server Clustering Requirements
In My webMethods Server, a cluster is defined as multiple My webMethods Server
instances that point to the same MywebMethodsServer database component. A cluster
can include My webMethods Server installations on different machines, server instances
within a My webMethods Server installation, or both.

This section is intended for use with the rest of the upgrade procedure. You must
perform all documented tasks for your products in the order they are wrien, with the
additional tasks or exceptions noted below.

Install Universal Messaging before installing My webMethods Server.

Note: Starting in 10.0, My webMethods Server clusters no longer use the server
database to exchange JMS events or as a JMS provider. Instead Universal
Messaging is required for synchronization among the cluster nodes.

When you install the new My webMethods Servers, create a cluster that matches
your old cluster. You can install the new My webMethods Servers in parallel.

When you install the fixes on the new My webMethods Servers, you can install the
fixes in parallel.

You do not need upgrade the Software AG Infrastructure as instructed in this guide.

When you shut down the old products, shut down all cluster nodes.

When you migrate server instances from old My webMethods Server installations to
new My webMethods Server installations, you can migrate the instances in parallel.

When you initialize the server instances, you can initialize them in parallel.

Configure the cluster as instructed in Administering My webMethods Server.

OneData Requirements
1. Go to the old_Software AG_directory /profiles/ODE/configuration/

com.softwareag.platform.config.propsloader directory. Open the
com.softwareag.catalina.connector.hp.pid-port .properties file and the
com.softwareag.catalina.connector.hps.pid-port .properties file and note the port
numbers.

2. Go to the indicated directory and open the file or files below.

Upgrade from 9.7 or 9.8: Go to the old_Software AG_directory /profiles/ODE/
configuration/tomcat/conf directory and open the context.xml file.
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Upgrade from 9.9 or later: Go to the old_Software AG_directory /profiles/ODE/
configuration/com.softwareag.platform.config.propsloader directory and open
the com.softwareag.catalina.resource.pid-repository_name schema .properties files,
where repository_name  is the repository name you provided during installation
and schema  is md, wa, or ra.

Note the database connection prefixes at the beginning of the names for the
metadata, work area, and release area schemas. For example, in the metadata
schema name jdbc/dev2md, the connection prefix is dev2. Also note any database
parameters such as maxIdle, maxActive, and maxWait that are specified for the
schemas.

3. Go to the old_Software AG_directory /profiles/ODE/bin/onedata/config directory.
Open the repository.xml file and note the Repository Id (RepositoryID element) and
Repository Name (Name element).

Universal Messaging Clustering Requirements
In Universal Messaging, a cluster is defined as multiple server instances in Universal
Messaging installations on the same or different machines that are configured for
clustering.

This section is intended for use with the rest of the upgrade procedure. You must
perform all documented tasks for your products in the order they are wrien, with the
additional tasks or exceptions noted below.

When you install the new Universal Messaging servers instances, create a cluster
that matches your old cluster. You can install the new Universal Messaging server
instances in parallel.

When you install the latest fixes on the new Universal Messaging server instances,
you can install the fixes in parallel.

When you shut down the old products, shut down all cluster nodes.

When you migrate server instances from old Universal Messaging installations to
new Universal Messaging installations, you can migrate the instances in parallel.

If the new cluster nodes are on the same host machines as the old cluster nodes, start
all new cluster nodes.

If the new cluster nodes are on different machines than the old cluster nodes, do the
following:

1. Go to the new_Software AG_directory /UniversalMessaging/
server/instance_name /bin directory for one cluster node and create a
file named remote_realms_bootstrap.conf. Add a cross-host mapping
property to the file for every node that is part of the cluster in the
format instance_name .address=new_host_name_or_IP  (for example,
umserver1.address=myUM1.com or umserver2.address=192.168.0.1). Copy the
file to the same location for all the other nodes.
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2. Start all cluster nodes. The remote_realms_bootstrap.conf file in every
installation will be renamed remote_realms_bootstrap_old.conf. When a source
Universal Messaging server instance is bound to a specific network interface
(absolute IP address), the interface of the migrated instance address will bind to
0.0.0.0 (all known interfaces on the port).

3. Open Enterprise Manager to make sure the cluster is running correctly.

Configure the cluster as instructed in Universal Messaging documentation

Database Requirements, Recommendations, and Preparation
Check your RDBMS against System Requirements for Software AG Products. If the
RDBMS version you are using is not supported by your new products, upgrade to a
supported RDBMS version.

Some products, like Integration Server, Microservices Runtime, Optimize, Process
Engine, and Trading Networks, offer features to archive or purge data from their
database components. You can reduce the amount of time needed to migrate
database components later in this procedure if you archive and purge them now. For
instructions, see the product documentation.

Make a backup of the product databases; shut down all ActiveTransfer, Integration
Server, Microservices Runtime, My webMethods Server, OneData, and Optimize
instances that connect to database components before making the backup. If you are
upgrading My webMethods Server, back up the My webMethods Server installation
directory at the same time you back up the database. If you have problems, you will
need to restore data from both types of backup.

Software AG strongly recommends using cloned databases when testing your
upgrade. You can clone only those database components that you will want to use
in your new environment. Cloning operations are typically done at the level of
the schema (Oracle) or database (SQL Server and DB2) that contains the product
database components, or at the level of the database user that owns all the database
components. Data cloning is usually performed using export and import tools that
are bundled with the database. For cloning procedures, see your database vendor
documentation.

Software AG recommends the following:

Installing Software AG Products describes the basic grants and privileges needed
to work with product database components. Before cloning the databases, give
the database users that will work with the cloned databases the same basic grants
and privileges that were given to the database users that work with the live
databases.

In some cases, one database user grants permissions to a second user (for
example, the process audit database user grants permissions to a second user to
archive process audit data). Before cloning the databases, create the second user
in the new schema or database.
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Use a separate database user (Oracle) or database (SQL Server or DB2) to host the
cloned databases.

The new release might require changes to the database components, such as new
tables, columns, keys, or indexes. You will run database migration scripts that
update the existing database schemas so they are compatible with the new product
release. The scripts might modify the existing database components, or might create
parallel database components with the new structure and then insert, select, rename,
and drop the tables, columns, keys, and indexes. These changes might increase the
size of your database.

Database migration may take many hours, depending on the volume of data, and is
often the critical path for upgrade.
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Install New Products Using Command Central
Follow the instructions in Software AG Command Central Help to install your new
products and fixes using Command Central.

Install New Products Using Software AG Installer
Follow the instructions in Using Software AG Installer, Installing Software AG Products, and
below to install your new products using Software AG Installer.

When running Software AG Installer:

1. For installation directory, specify a new Software AG installation directory.

2. On the product tree, Database Configuration in addition to the new products to
install.

3. On product panels or in response to prompts, provide the requested data.

Note: If you are installing the new products on the same machine as the old
products, the installer often allows you to assign ports used by an old
product to the new product as well, even if the old product is running.
Assigning the same ports means you will not need to edit port values in
assets and clients when you begin using the new release.

The table below describes the data to provide on installer panels or in response to
prompts for the indicated products.

Product Guidelines

ActiveTransfer
Server

Point the database connection at the ActiveTransfer database
component you want to use with the new ActiveTransfer
Server.

Apama If installing the new Apama on the same machine as the
old Apama, specify a new work directory. Software AG
recommends including the release number in the work
directory name, as shown in the default.

Integration
Server or
Microservices
Runtime

Point the database connection at the ISInternal database
component you want to use with the new Integration Server
or Microservices Runtime.
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Product Guidelines

My
webMethods
Server

Select Side-by-side installation for upgrade. No instance will be
created.

OneData Enter the values you noted earlier from the old installation
for ports, repository ID, repository name, and database
connection prefixes and parameters. Make sure the database
connections point to the OneData database components you
want to use with the new OneData.

Note: Reusing port values means that Web service clients of
the old OneData will not have to change URLs to access
the new OneData.

Trading
Networks

Point the database connection at the TradingNetworks
database component you want to use with the new Trading
Networks.

Universal
Messaging

Select Side-by-side installation for upgrade. No instance will be
created.
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Install Latest Fixes on New Products
The instructions in Installing Software AG Products include installing the latest fixes on
your new products.

Install the latest product fixes on all new products except the infrastructure
components named Common Platform and Security Infrastructure. Also do not
install the latest fixes on the database scripts. You will apply those fixes later in the
procedure.

For some products, fixes relating to migration are separate from product fixes. Install
the latest migration fixes on all new products, including Common Platform and
Security Infrastructure. Fix names for those products typically include the leers
OSGI and SIN, respectively.

Install the latest migration framework fix. Fix names for the migration framework
follow the convention MIG_release _MigrationFramework_Fixnumber  and are listed
under Common Library.

Important: If your upgrade procedure take days or weeks to complete, continue to check
for and install new fixes regularly during the procedure.

Shut Down Software AG Runtime and Disable Automatic
Startup
Software AG Runtime starts automatically after installation. Shut down Software AG
Runtime by stopping the Windows service or UNIX daemon. You can use the shutdown.
{bat|sh} scripts in new_Software AG_directory /profiles/CTP/bin directory.

If you installed your new products on a Windows system, and you installed them as
Windows services, the default startup mode for the services is Automatic. To prevent
the new products from starting accidentally before this procedure instructs you to
start them, set the services to Manual. If you installed on a UNIX system, and you have
scripts that automatically start daemons, disable the scripts for the same reason.

Important: Do not start any of the new products at this point. Do not start any of the
new products before the instructions in this guide explicitly tell you to do so,
or your database components could become corrupted.
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Prepare the Old Environment for Migration

Install Fixes on Old Products
Install the latest product fixes on the old ActiveTransfer, API Gateway, API Portal,
CentraSite, Infrastructure Data Collector, My webMethods Server, Optimize, and
Process Engine. After you install the fix on the old product, start the old product.

Upgrade from 10.1: Prepare the Old API Gateway
In this section you will do the following:

Create a ZIP file containing backups of the configurations for the old Integration
Server that hosts API Gateway, the API Gateway UI and dashboard (Kibana), and for
one API Gateway instance. You can migrate only one API Gateway instance.

Create a snapshot of the Event Data Store. The Event Data Store contains the
following:

APIs.

Applications.

Policies and policy actions.

Configurations and administrator seings.

Aliases.

Users, groups, and access profiles.

Plans, packages, and subscriptions.

API events for transactions, monitoring, policy violations, threat protection,
lifecycle, and errors.

Performance metrics.

Follow the steps below to migrate create the configuration backups and the Event Data
Store snapshot.

1. Start the old API Gateway.

2. Open a command window or shell and go to the old_Software AG_directory /
IntegrationServer/instances/instance_name /packages/WmAPIGateway/cli/bin
directory, where instance_name  is the API Gateway instance to migrate. Then run the
command below.

The -backupDestinationDirectory parameter is the directory in which to store the
ZIP file containing the configuration backups, and the Event Data Store snapshot.
The directory must already exist and you must have write permissions to it. The
snapshot will be stored in a sub-directory named default. The ZIP file and the
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snapshot will be named apigw_upgrade_backup.zip and apigw_upgrade_backup,
respectively.
apigw-upgrade-backup.[bat|sh]
-backupDestinationDirectory full_path_to_directory_for_
configuration_backups_ZIP_file_and_EDS_snapshot

3. If the old and new API Gateway installations are on different machines, copy the -
backupDestinationDirectory to the new machine.

Prepare the Old API Portal
1. Start the old API Portal Cloud Controller.

2. If the old API Portal is installed in a clustered, high-availability setup, make sure
all nodes are running and accessible to the ZooKeeper ensemble. Then register each
node with the parent node by running this command:
acc> add node logical_node_name IP_address_or_host_name
[@port ] user_name password

3. Run this command:

acc> startall

4. Run this command to make sure all API Portal components are running:

acc> list

5. For each tenant in the old API Portal, you will have to create a tenant in the new API
Portal. List all tenants in the old API Portal by running this command:
acc> list tenants

6. Back up each old tenant’s API and related data; user data; API Portal document
storage data, including all access rights; and collaboration data to a file. The file
extension .acb will automatically be added to each file.

The table below explains how to back up each old tenant’s data to a file for each old
product release.

Old
Release

Commands to Run

9.7 acc> set acc config backup.restore.tenant.app.types = com.aris.
umcadmin.y-umcadmin-run-prod, com.aris.modeling.components.
y-server-run-prod, com.aris.adsadmin.y-adsadmin-run-prod, 
com.aris.runnables.ecp-run-prod
acc> set acc config backup.restore.tenant.app.type.names = umc, 
abs, ads, ecp
acc> backup tenant tenant_name  to full_path_to_backup_file
username=your_user_name  password=your_password

9.8 acc> set acc config backup.restore.tenant.app.types=UMC,ABS,ADS,ECP
acc> backup tenant tenant_name  to full_path_to_backup_file
username=your_user_name  password=your_password
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Old
Release

Commands to Run

9.9
9.10
9.12

10.1

10.2

acc> backup tenant tenant_name  to full_path_to_backup_file
username=your_user_name  password=your_password

7. If you created a customized view of your old API Portal, back up the view as
follows:

a. Open API Portal in a browser and log on with Administrator credentials.

b. Go to the Administration page. In the Views page under the Customization section,
hover over the name of the custom view and click Backup. API Portal creates a
ZIP file that contains the customized view.

c. Save the ZIP file.

Prepare the Old CentraSite
1. If you changed seings for CentraSite Control from their defaults, note those seings

so you can make the same changes in the new CentraSite installation.

2. If the new and old CentraSites are on the same machine, make sure the old
CentraSite is shut down.

3. Export configuration data from the old CentraSite and assets from the old Registry
Repository into a ZIP file. On the old machine, open a command window or shell,
go to the old_Software AG_directory /CentraSite/utilities directory, and run the
appropriate command below.

For Windows, run sbsExport.cmd full_path_to_ZIP_file

For UNIX, run sbsExport.sh full_path_to_ZIP_file

An example of this command for UNIX is as follows:
./sbsExport.sh /tmp/sbs_cs82_data.zip

4. If the old and new CentraSite installations are on different machines, copy the ZIP
file to any directory on the machine that hosts the new CentraSite.

Prepare the Old Deployer
Start the old host Integration Server. In the old Deployer, edit all connections to old
source and target product servers to point to the new source and target product servers.
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You do not have to supply user names and passwords if you do not know them. For
instructions, see webMethods Deployer User’s Guide.

Prepare the Old Software AG Designer

Export Integration Server or Microservices Runtime Definitions
1. In the old Software AG Designer, go to Window > Preferences. On the Preferences

dialog box, in the left navigation bar, go to Software AG > Integration Servers.

2. Click Export and complete the dialog box. Software AG Designer will save the file
with the extension .properties.

Export CloudStreams Server Definitions and Projects
1. To export CloudStreams Server definitions to file, go to Window > Preferences >

Software AG > CloudStreams Servers. Click Export and complete the dialog box.
Software AG Designer will save the file with the extension .properties.

2. Open the CloudStreams Development perspective.

In the CloudStreams Governance view, right-click a governance project to export,
click Export, and complete the wizard. The project folder will be exported.

In the CloudStreams Providers view, right-click the provider project to export, click
Export, and complete the wizard. The projects will be exported as an archive (ZIP
file).

Export Preferences
If you want to migrate your preferences to the new Software AG Designer, you export
them from the old Software AG Designer and then import them into the new Software
AG Designer. To export the preferences, do the following:

1. In the old Software AG Designer, open the File > Export wizard. In the Select panel, go
to General > Preferences and click Next.

2. In the To preference file field, specify the name of the file to which you want to export
your preferences. Software AG Designer will save the file with the extension .epf.

Prepare the Old Integration Server or Microservices Runtime

Note: Steps for Microservices Runtime are identical to those for Integration Server.

Start and Connect Products
1. Start the old Integration Server and open the old Integration Server Administrator.

2. If you are using Universal Messaging, make sure Integration Server is connected
to each Universal Messaging server that is acting as a webMethods Messaging
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provider. If you are using another JMS provider, make sure Integration Server is
connected to the JMS provider.

Suspend Triggers and Drain Queues

Upgrade from 9.8: Suspend Triggers and Drain Queues When Using Command Central to Upgrade

You can suspend triggers and drain message queues by pausing the Integration Server
instance from Command Central.

Suspend Triggers and Drain Queues Using When Not Using Command Central
to Upgrade
1. Go to Settings > Quiesce page. Click Enter Quiesce mode and set the time for the quiesce

to occur to at least 1 minute, so Integration Server has time to stop executing new
incoming requests and to finish executing in-flight services. Make sure the Quiesce
Report shows the status SUCCESS in every field. For instructions and details about
specific actions that occur when Integration Server is quiesced, see webMethods
Integration Server Administrator’s Guide.

2. Go to the Settings > Messaging > webMethods Trigger Management page. If the Current
Queue Counts field does not show 0 for every trigger, diagnose and fix the problem
(for example, the webMethods Messaging provider might not be active or might be
slow to process requests from Integration Server). Refresh the page until the Current
Queue Counts field shows 0 for every trigger.

3. Go to the Settings > Messaging > webMethods Messaging Settings page. Make sure the
CSQ Count field shows 0 for the Universal Messaging connection alias.

4. Go to the Settings > Messaging > JMS Settings page. In the JMS Connection Alias
Definitions area, make sure the CSQ Count field shows 0 for every JMS connection
alias.

Prepare the Old MashZone NextGen
Upgrade from 9.10 or 9.12: MashZone NextGen 10.0 and later do not support the PPM
Chart View. To remove the view from the MashZone NextGen database, open the
MashZone NextGen Developer or MashZone NextGen Administrator, go to the API
Console, and send this request:
{
  "version": "1.1",
  "sid": "AppService",
  "oid": "removeApp", 
  "svcVersion": "0.1", 
  "params": [ 
    "ppm-chart"
  ]
}

A response of true indicates that the view has been removed.



M
Even Header

Prepare New Products, Old Products, Database Components, and ZIP Files for Migration

Upgrading Software AG Products Version 10.3 42

Prepare the Old My webMethods Server
When you edit configuration seings for My webMethods Server, you download the
appropriate configuration file from the MywebMethodsServer database component
to the My webMethods Server installation and make the changes in that file. You then
either upload the file to the database component and delete it from the file system, or
keep it in the file system so its seings are used in preference to the equivalent seings
in the database. Go to the old_Software AG_directory /MWS/server/instance_name /config
directory and check for any such files. If you do not want such files to be migrated to the
new installation, delete them from the old installation.

Prepare the Old OneData
1. In the old OneData, go to the Home > Administer > Job Center page. On the Filter page,

for each job type, filter by Active or Pending Active. If a job has one of these statuses,
terminate the job or wait for it to complete.

2. If you are using JMS with OneData, go to the old_Software AG_directory /profiles/
ODE/webapp/onedata/WEB-INF/lib directory and back up all client jar files required
for JMS providers.

3. If you are using Kerberos authentication with OneData, back up your Kerberos-
based SSO configurations and files.

The table below lists the directories that contain the Kerberos-based SSO
configurations and files to back up.

old_Software AG_directory / Files to Back Up

profiles/ODE/configuration/tomcat/conf server.xml

profiles/ODE/configuration custom_wrapper.conf and
jaas.config

profiles/ODE/workspace/webapps/onedata/
WEB-INF

web.xml

profiles/ODE/configuration/
com.softwareag.platform.config.propsloader

All com.softwareag.jaas.
realm.pid-SSO_realm_name

Prepare the Old Optimize
1. If you want to reuse your Central Configurator System (CCS) Environment

definition, export the environment to an XML file. In My webMethods, go to the
Administration > System-Wide > Environments > Define Environments page. Select the check
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box next to the environment, click Export, and provide a file name and location for
the exported environment.

2. If you want to cluster Analytic Engines in the new installation, you will need
a Terracoa Server Array. For planning information, see  Using Terracoa with
webMethods Products, Configuring BAM, and the Terracoa BigMemory Max
documentation.

Prepare the Old Zementis Predictive Analytics
1. Go to the old_Software AG_directory /Zementis/adapa-app/migration directory.

2. Back up Zementis Predictive Analytics models and resources by running this
command:
./migration.sh backup Zementis_host_URL admin_user admin_password

The backup is wrien to the adapa-backup-yymmdd -hhmmss  directory, where
yymmdd -hhmmss  is the time you ran the command based on the UTC time zone.

Shut Down the Old Products

Shut Down Old Products Using Command Central
Shut down products from Command Central.

Shut Down Old Products Manually
The table below lists how to shut down specific products.

Product Shut Down Instructions

API Portal If the old and new API Portal are on the same machine:

Run this command in the old API Portal Cloud Controller:
acc> stopall

Stop the cloud agent by going to the old_Software AG_directory /
API_Portal/server/bin directory and running this command:
CloudAgentApp.{bat|sh} stop

CentraSite If the old and new CentraSite are on the same machine,
shut down all old Application Server Tiers by stopping the
Software AG Runtime services, then shut down the old Registry
Repository by stopping its service.

EntireX Shut down EntireX as instructed in the previous table, then
shut down all Brokers, RPC Servers, and customer applications
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Product Shut Down Instructions
that use EntireX libraries. For instructions, see the product
documentation for your old release.

Terracoa Shut down all non-webMethods clients.

To shut down the other products on a Windows system.

If the product is running as a service, shut down from the Windows Services
window. Services are listed as Software AG product release.

If the product is running as an application, shut down from the Windows start
menu. Applications are listed as Software AG > Stop Servers > product.

On a UNIX system, use the instructions in the product documentation for your old
release.

Note: It is especially important to shut down all old ActiveTransfer, Integration
Server, Microservices Runtime, My webMethods Server, OneData, and
Optimize instances that connect to database components you are going to
migrate.

Prepare Database Components for Migration

Overview
The new release might require changes to the database components, such as new tables,
columns, keys, or indexes. In this section, you run database migration scripts that
update the existing database schemas so they are compatible with the new product
release. The scripts might modify the existing database components, or might create
parallel database components with the new structure and then insert, select, rename,
and drop the tables, columns, keys, and indexes. These changes might increase the size
of your database.

Special Considerations for Migrating Database Components
If you are using business processes, you have stored information about in-progress,
completed, or failed business process instances. This stored information is called
business process runtime data. If you do not want to finish running in-progress
process instances or resubmit completed or failed process instances from your old
installation in your new installation, do not migrate your business process runtime
data.
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If you are using Optimize with a DB2 RDBMS, there are special considerations for
the URL you specify on the database component migration command. You must do
the following:

Specify the schema name in the URL using all capital leers.

Specify the options CreateDefaultPackage=true,ReplacePackage=true, and
DynamicSections=3000. These seings will affect all database components in
the same schema or database.

Before You Migrate Trading Networks Database Components
If you created custom indexes for your Trading Networks database components, check
whether those custom indexes conflict with indexes that will be created when you run
the Trading Networks database migration scripts in the next step. If so, drop the custom
indexes.

The table below lists the directories under the new_Software AG_directory /common/db/
scripts/RDBMS /tradingnetworks/migrate directory that contain the database migration
scripts for Trading Networks for each release.

Old
Release

Directories

9.7 /50_to_55

9.8 /55_to_56 and 56_to_65

9.9 /65_to_70

Install Fixes on Database Migration Scripts
If you are using Command Central to migrate database components, follow the
instructions in Before Creating Database Components in the Software AG Command Central
Help to install the latest fix on the database migration scripts.

If you are using the Database Component Configurator to migrate database components,
use Software AG Update Manager to install the latest fix on the database migration
scripts.

Database script fix names follow the convention
DC_old_release_number _DBS_Fixlatest_fix_number .
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Create ZIP Files as Source of Old Product Installations to
Migrate
If your old and new installations for a product are on different machines, create a ZIP
file of the old product installation to use as the migration source.

Create ZIP File When Using Command Central to Migrate
If you are upgrading one environment using Command Central, you can to create ZIP
files of the old installations from Command Central or create them yourself as described
in the next section.

If you are using composite templates to automate the upgrade, Command Central
automatically creates a ZIP file of each old installation directory. The ZIP file includes all
files except .log files. If you want to decrease the size of the ZIP file, see the table in the
next section for the commands that will include only the required files for each product
in the ZIP file.

Create ZIP File When Using Migration Utilities to Migrate

Create a ZIP File for My webMethods Server
1. On the old machine, open a command window or shell, go to the old_Software

AG_directory /MWS/bin/migrate or old_Software AG_directory  /MWS/bin directory,
depending on which old release you have, and run the command ZIP-mws.{bat|
sh}. The command creates a ZIP file named mws.zip in old_Software AG_directory /
MWS/migrate-zip directory.

2. Copy the mws.zip file to any directory on the machine that hosts the new My
webMethods Server.

Important: If using FTP to copy, use the binary file transfer mode\type. If you use
another mode\type, the ZIP file might become corrupted.

Create ZIP Files for All Other Products
The instructions below use the Java Archive tool to create the ZIP file. Specify the
location of the Java Archive tool in the JAVA_HOME and PATH system variables on
the machine that hosts the old product installation. The tool is located in the Software
AG_directory /jvm/jvm/bin directory.

Note: On some systems, the lower-level jvm directory name includes additional
information, such as /jvm/jvm160_32, or /jvm/jvm170, or /jvm/jvm_64.
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1. Go to the product’s old machine and open a command window or shell.

2. Go to the Software AG directory that contains the old product and enter the
command indicated in the table below. If multiple commands are listed, use the
same ZIP file name in each command.

3. Copy the product’s ZIP file to any directory on the machine that hosts the new
product.

Important: If using FTP to copy, use the binary file transfer mode\type. If you use
another mode\type, the ZIP file might become corrupted.

The table below lists the command to run to create a ZIP file of the old product
installation to use as the migration source.

Product Command to Run

Application
Platform

You can reduce the ZIP file size by first moving the log files out of the
old_Software AG_directory /profiles/product /logs directory, where product
is the host Integration Server instance, the host My webMethods Server
instance, or SPM (for Platform Manager).
jar cfM ZIP_file_name .zip install/products profiles

Digital Event
Services

If your installation includes the file migrate.{bat|sh} in the new_Software
AG_directory /common/migrate/DigitalEventServices/bin directory:
jar cfM ZIP_file_name .zip install/products
jar ufM ZIP_file_name .zip common/DigitalEventServices

If the following directories exist, add them to the ZIP file:
jar ufM ZIP_file_name .zip profiles/product
/configuration/DigitalEventServices

Event
Routing

If your installation includes the file migrate.{bat|sh} in the new_Software
AG_directory /common/migrate/EDA/bin directory:
jar cfM ZIP_file_name .zip install/products
jar ufM ZIP_file_name .zip common/conf
common/EventTypeStore

If the following directories exist, add them to the ZIP file:
jar ufM ZIP_file_name .zip profiles/product /configuration
/event/routing optimize/analysis/conf/event/routing

Software AG
Infrastructure
(specifically,
Software AG
Runtime)

You can reduce the ZIP file size by first moving the log files out of the
old_Software AG_directory /profiles/CTP/logs directory.
jar cfM ZIP_file_name .zip common/conf install/products
profiles/CTP

You might see the message profiles/CTP: no such file or directory.
You can ignore this message.
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Product Command to Run

Infrastructure
Data
Collector

You can reduce the ZIP file size by first moving the log files out of the
old_Software AG_directory /profiles/InfraDC/logs directory.
jar cfM ZIP_file_name .zip common/conf install/products
profiles/InfraDC

Integration
Server or
Microservices
Runtime

You can reduce the size of the ZIP file by first moving the log files out of the
old_Software AG_directory /profiles/instance_name /logs, /IntegrationServer/
instances/logs, and /IntegrationServer/instances/instance_name /logs
directories.
jar cfM ZIP_file_name .zip *

MashZone
NextGen

jar cfM mzng.zip MashZoneNG

OneData jar cfM ZIP_file_name .zip install/products
profiles/ODE/bin/onedata/config/*

Universal
Messaging

jar cfM ZIP_file_name .zip install/products 
UniversalMessaging/server
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Caution

Important: After you migrate database components to the new release, you can no
longer use them with your old environment.

Migrate Database Components Using Command Central
Use the Command Central command sagcc exec administration to migrate
database components. The command syntax is shown below. The parameters are the
parameters you use when running the Database Component Configurator and are
documented in Installing Software AG Products.
sagcc exec administration product DCC_node_alias  DatabaseComponentConfigurator
database migrate [parm1=value1  ] [parm2=value2  ]...

In the examples below, the database components are on a SQL Server RDBMS at
jdbc:wm:sqlserver://DBserver:1433;databaseName=TESTDB, and the database user is
webmuser with password webmpass.

To upgrade Integration Server database components from 9.9 to the latest release:
sagcc exec administration product local DatabaseComponentConfigurator
database migrate db.type=sqlserver product=IS version=latest
db.username=webmuser db.password=webmpass db.name=TESTDB
db.url=“jdbc:wm:sqlserver://DBserver:1433;databaseName=TESTDB”

To upgrade the My webMethods Server database components to the latest release:
sagcc exec administration product local DatabaseComponentConfigurator
database migrate db.type=sqlserver component=MWS version=latest
db.username=webmuser db.password=webmpass db.name=TESTDB
db.url=“jdbc:wm:sqlserver://DBserver:1433;databaseName=TESTDB”

To check the progress of the migration in Command Central, click Jobs on the
Command Central web user interface.

Migrate Database Components Using Database Component
Configurator
On the machine on which you installed the new Database Configuration, open a
command window or shell, go to the new_Software AG_directory /common/db/bin
directory, and migrate database components by running the command below.
dbConfigurator.{bat|sh} -a migrate -d {oracle|sqlserver|db2luw} 
{-c db_component  | -pr product } -v latest -l db_server_URL
-u existing_db_user  -p password

After you run each command, check the log file dcc_yyyymmddhhmmss  in the
new_Software AG_directory /common/db/logs directory.
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If you are using an Oracle or DB2 RDBMS, and you are not using the default tablespace,
also specify the -tsdata data_tspace_name and -tsindex index_tspace_name
parameters.

On an AIX, HP-UX, or Solaris system, enclose the values “db_server_URL”,
”existing_db_user”, and “password” in quotation marks.

If you are upgrading... Values for product ...

Integration Server or
Microservices Runtime

-pr IS

Note: Migrate the Integration Server or Microservices
Runtime database components before
migrating other database components.

ActiveTransfer Server -c ActiveTransfer

API Gateway -c APIGatewayEvents

Business process runtime
data and Business Rules

-pr BPM

Archive, Staging, or
Reporting database
components

-c {Archive|Staging|Reporting}

My webMethods Server -pr MywebMethodsServer

OneData -c {OneDataMetadata|OneDataReleaseArea|OneDataWorkArea}

Optimize -pr OPTIMIZE

Trading Networks -pr TN

Migrate the DynamicBusinessOrchestrator Database
Component
Run these SQL statements against the DynamicBusinessOrchestrator database
component:
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RDBMS 

Oracle,
DB2,
MySQL

UPDATE PRA_PROCESS_RECENT P SET
P.system = (SELECT DISTINCT PD.TYPE FROM WMPROCESSDEFINITION PD 
WHERE PD.PROCESSKEY = P.PROCESSKEY)
UPDATE PRA_PROCESS_RECENT P SET
P.system = (SELECT DISTINCT PD.TYPE FROM WMPROCESSDEFINITION PD 
WHERE PD.PROCESSKEY = P.PROCESSKEY)

SQL
Server

UPDATE PRA_PROCESS SET PRA_PROCESS.system = WMPROCESSDEFINITION.TYPE
FROM PRA_PROCESS, WMPROCESSDEFINITION WHERE WMPROCESSDEFINITION.
PROCESSKEY = PRA_PROCESS.PROCESSKEY;
UPDATE PRA_PROCESS_RECENT SET PRA_PROCESS_RECENT.system = 
WMPROCESSDEFINITION.TYPE
FROM PRA_PROCESS_RECENT, WMPROCESSDEFINITION WHERE WMPROCESSDEFINITION.
PROCESSKEY = PRA_PROCESS_RECENT.PROCESSKEY;
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Software AG Infrastructure Configurations, Data, and Assets
that Will be Migrated

Software AG Runtime audit, debug, JAAS, JMX, port, security, single-sign on,
watchdog, and Web Services Stack configurations.

Journal log seings, user repository, and password store.

Java Service Wrapper customizations you made in the old custom_wrapper.conf
files, including #include directives and comments (but not associated properties).

Users, groups, and roles.

Proxy configuration files for proxy types HTTP, HTTPS, FTP, and SOCKS. The utility
migrates files for proxies that are not already configured in the new installation.

Starting in 10.0, Software AG Security Infrastructure no longer supports SSX or SSX
LoginModules. The migration utility migrates LoginContexts that do not contain SSX
LoginModules. However, if an old LoginContext contains SSX LoginModules, the
migration utility does the following:

If LoginContext exists in old and new release, the utility adds a comment to the
new LoginContext that no migration was performed.

If LoginContext exists in old release but not in new release, the utility adds an
empty LoginContext to the new release with comment that no migration was
performed. This is to prevent software that used the old LoginContext from
failing because of missing context.

Starting in 10.1, the migration utility does not support migration of JKS files that are not
in the Software AG installation directory.

Migrate Software AG Infrastructure
Infrastructure components are automatically installed with products. These components
are the Software AG Common Platform, Software AG Runtime, Software AG Security
Infrastructure, and Software AG Web Services Stack.

1. Make sure none of the new products are running. If the new and old products are on
the same machine, make sure the old products are shut down.

2. You can migrate using the migration utility; follow the instructions in “Migrate
Products Using Migration Utilities” on page 127. Software AG Infrastructure
cannot be upgraded using Command Central.
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Complete the Software AG Infrastructure Upgrade
Go to the old_Software AG_directory /profiles/CTP/configuration/
com.softwareag.platform.config.propsloader directory and copy all
files to the new_Software AG_directory /profiles/CTP/configuration/
com.softwareag.platform.config.propsloader directory.

#include directives are migrated to the end of the new custom_wrapper.conf file;
check them and adjust as necessary. The custom_wrapper.conf file is located in the
Software AG_directory /profiles/CTP/configuration directory.

Note: As noted in the Software AG Infrastructure Administrator's Guide, you
should never modify the wrapper.conf file unless instructed to do so by
Software AG. If you did so, however, manually copy values for properties
you modified in the old wrapper.conf file to the corresponding properties
in the new custom_wrapper.conf file.
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Migrate Terracotta BigMemory
This section explains how to migrateTerracoa BigMemory Max clients and servers that
are deployed in support of webMethods products. For all other setups, see the Terracoa
BigMemory Max documentation.

Follow the instructions in  Using Terracoa with webMethods Products to install the 4.1.4 or
later license key and tc-config.xml file.

You must upgrade all Terracoa BigMemory Max clients and servers in the cluster to the
new release before restarting the cluster.

If you have a single server:

1. Shut down your old Terracoa Server Array.

2. Start the new Terracoa Server Array.

If you have a mirror group consisting of an active server and a mirror server:

1. Shut down the old mirror server.

2. Shut down the old active server.

3. Start the new active server.

4. Start the new mirror server.

Migrate Terracotta DB
Terracoa DB 10.3 is significantly different from Terracoa BigMemory Max 4.x
and 3.7.6 in terms of handling of cluster topology, data storage formats, and other
functionality. You cannot migrate data and configuration for a Terracoa BigMemory
Max server to a Terracoa DB server. You cannot migrate TCStore data.

Migrate Terracotta Management Console Configuration and Data
1. Go to the old_Software AG_directory /TerracoaDB/tools/management/conf directory

and copy the tmc.properties file over the same file in the new installation.

2. Go to the old_Software AG_directory /TerracoaDB/tools/management directory and
copy the data directory to the same location in the new installation.

3. Start Terracoa Management Console.

4. If you receive error messages, open the tmc.properties file and make sure all the
properties are set correctly. For instructions, see the product documentation.
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Migrate Ehcache Data
If you have Ehcache data in restartable caches contained in a restartable cache manager,
you can migrate that data to a new cluster without moving the platform data roots.
Since the data migration works at the data directory level, data for all restartable cache
managers that use the same data directory will be migrated together.

1. Shut down the old cluster.

2. Start the active servers in the new cluster with the same number of stripes as the old
cluster.

3. Create the cache manager configuration using a client. The cluster URI, including
the cluster tier manager name for the cache manager, can be different from the URI
for the old cluster. If the name part of the URI is different, specify the old name as
the restart identifier when using the cache manager configuration API, so the system
can map the data corresponding to a given cache manager correctly. If there is more
than one cache managers under the same data directory, use the configuration API to
create all the cache managers in the target cluster. For instructions, see the section on
fast restartability in the Ehcache API Developer Guide.

4. Shut down the new cluster.

5. For all restartable cache managers on all servers you want to migrate, copy the
contents of the Ehcache directories (caching data roots) from the data directories of
all active servers in the old cluster to the data directories in the new cluster. The data
directory paths on the new cluster can be different from those on the old cluster.

6. Start the new cluster. Terracoa DB will load all the cache data that was migrated
from the old cluster.
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Universal Messaging Configurations, Data, and Assets that
Can be Migrated

Server instances.

Server instance data directories.

Migrate Universal Messaging
1. If you are upgrading a Universal Messaging cluster, read the clustering instructions

in the Universal Messaging documentation.

2. If the new and old Universal Messaging installations are on the same machine, make
sure the old installation is shut down.

3. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below. If you want to use a custom migration, first run the migration utility
manually to create the migrate.dat file (see “Migrate Products Using Migration
Utilities” on page 127 for instructions), then specify the migrate.dat file on the
importFile parameter. If you want to migrate all instances, do not specify the
instanceName option.
sagcc exec administration product target_node_alias
NumRealmServer migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}
[importFile=full_path_to_migrate.dat ]
[instanceName=name [,name ...]]

If you installed Template Applications and Enterprise Manager in the new
installation, the migration creates Template Applications and Enterprise Manager
instances.

Complete the Universal Messaging Upgrade
1. In release 9.8, the nserver.conf and nserverdaemon.conf files were combined into a

single file named Server_Common.conf. The Server_Common.conf file is stored in
the new_Software AG_directory /UniversalMessaging/server/umserver/bin directory.

Upgrade from 9.7: If you made any custom changes to the nserver.conf or
nserverdaemon.conf file for an old instance, make the same changes to the
Server_Common.conf file for the corresponding new instance. The nserver.conf
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and nserverdaemon.conf files are stored in the old_Software AG_directory /nirvana/
server/umserver/bin directory.

Upgrade from 9.8, 9.9, or 9.10: If you made any custom changes to the
Server_Common.conf file for an old instance, make the same changes in the
Custom_Server_Common.conf file for the corresponding new instance.

Upgrade from 9.12 or 10.1: If you made any custom changes to the
Server_Common.conf or Custom_Server_Common.conf file for an old instance,
make the same changes in the Custom_Server_Common.conf file for the
corresponding new instance.

2. If the data directory for an old instance was not in the default location specified in
the Software AG Installer, the migration utility did not migrate the data directory.
The default location for the data directory is the new_Software AG_directory /
UniversalMessaging/server/instance_name /data directory. You can use the old data
directory in the old location or copy it to a new location. If you copy it, edit the
DDATADIR parameter in the Server_Common.conf file for the new instance to point
to the new data directory location.

3. If you modified the old default JAAS configuration file, go to the old_Software
AG_directory /UniversalMessaging/server/server_name /bin directory, open the
jaas.conf file, and copy the changes to the same file in the new installation. Also
copy references to external resources such as truststore files and then modify the
references as necessary.
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My webMethods Server Configurations, Data, and Assets that
Can be Migrated

Server instances.

If the old My webMethods Server hosted Business Console, the user preferences,
AppSpaces, and gadgets for Business Console.

Java Service Wrapper customizations you made in the old custom_wrapper.conf
files, including #include directives and comments (but not associated properties).

Other Actions Performed as Part of the Migration
Deletes old configuration files that are not used by the new My webMethods Server,
and deletes old properties that are not used by the new My webMethods Server from
the new configuration files.

Synchronizes the My webMethods Server installation directory with the database.

If you specified a URL for Universal Messaging, updates the existing JNDI URL
parameter or adds a new JNDI URL parameter to the cluster.xml file, as appropriate.

Embedded Database No Longer Supported
Starting in My webMethods Server 10.3, My webMethods Server no longer offers an
embedded database, so the My webMethods Server migration utility will not migrate
instances that used an embedded database. Instead you can create a new instance,
and then transfer applications and content from the old instance to the new instance
using Deployer or the content import/export functionality of My webMethods Server.
For instructions, see webMethods Deployer User’s Guide or Administering My webMethods
Server, respectively.

Migrate My webMethods Server
1. If you are upgrading a My webMethods Server cluster, read “ My webMethods

Server Requirements” on page 26.

2. If the new and old My webMethods Servers are on the same machine, make sure the
old My webMethods Server is shut down.

3. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.
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To migrate using Command Central, use the Command Central command
below. If you want to use a custom migration, first run the migration utility
manually to create the migrate.dat file (see “Migrate Products Using Migration
Utilities” on page 127 for instructions), and then specify the migrate.dat file on
the importFile parameter. If you want to migrate all instances, do not specify
the instanceName option.
sagcc exec administration product target_node_alias
MwsProgramFiles migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}
[importFile=full_path_to_migrate.dat ]
[instanceName=name [,name ...]]
[newNodeName=instance_name :new_node_name [,instance_name :new_node_name ...]]
[cloneDbURL=URL  cloneDbUser=user  cloneDbPassword=password ]

Complete the My webMethods Server Upgrade

Check Java Service Wrapper #include Directives
The migration utility migrates #include directives to the end of the new
custom_wrapper.conf file; check them and adjust as necessary. The
custom_wrapper.conf file is located in the Software AG_directory /profiles/
MWS_instance_name /configuration directory.

Note: As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf file unless instructed to do so by Software AG.
If you did so, however, manually copy values for properties you modified
in the old wrapper.conf file to the corresponding properties in the new
custom_wrapper.conf file.

Initialize a My webMethods Server Instance
The initializing process might take several hours.

1. Initialize the new My webMethods Server server instance by going to the
new_Software AG_directory /MWS/bin directory and running this command:
mws.{bat|sh} -s instance_name  init

The new components are deployed, and then the instance shuts down automatically.
Restart the instance.

2. If the old and new My webMethods Server installations are on different machines,
verify the host name for the new installation as follows:

a. Log on to one of the new My webMethods Server instances as Administrator and
go to the Administration > My webMethods> Cluster Settings > Advanced Web and Cluster
Configuration for MWS page.
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b. If the host name is not correct in the Host and MWS Front End URL field, update the
host name.

c. Go to the Cluster Status and Control page and restart the instance.

Switch from Clone to Live Database
If you used a clone database to test your new installation (recommended), and you
later want to use your live database with the new installation you tested, you must
run the My webMethods Server migration utility again to make the switch. The utility
synchronizes the My webMethods Server installation directory with the database.

1. Run the My webMethods Server migration utility again.

2. Migrate each server instance again. When the utility asks for the database to use with
each instance, choose the live database.

3. When the migration utility asks whether to delete or keep the migrated instances in
the new installation, choose to delete the migrated instances.

Complete Business Rules Upgrade
Business Rules projects currently deployed to My webMethods Server are migrated
when you first start a server instance. In a cluster, the first cluster node to start up
migrates all rule projects. During this migration, all rule projects deployed on My
webMethods Server are unavailable. The My webMethods Server log file contains
details about the rule project migration. By default, the log file is stored in the Software
AG_directory /MWS/server/instance_name /logs directory.

1. If the new installation directory has a different name than the old installation
directory, check the validity of the file system location used by Deployer for
Business Rules asset deployment, and restart My webMethods Server if updates
are necessary. For instructions, see Working with Business Rules in My webMethods,
chapter "Hot Deploying and Merging Rule Projects with webMethods Deployer" and
section "Configuring My webMethods Server."

2. If you use business verification or data providers, log on to one of the new My
webMethods Server instances as Administrator and go to the Administration > My
webMethods > System Settings > webMethods Business Rules Settings page. Update the
seings as necessary and save the changes.

For more information, see Working with Business Rules in My webMethods. For
business verification, see chapter "Rule Verification Overview" and section
"Configuring a Server Connection for a PreconfiguredVerification." For data
providers, see chapter "Working with Decision Tables" and section "Configuring a
Server Connection for a Pre-configured Data Provider Service."
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Integration Server and Microservices Runtime
This chapter applies to Microservices Runtime as well as to Integration Server.

Packages
This guide refers to different types of packages for Integration Server, as follows:

Custom packages. These include Integration Server packages created by users in
Software AG Designer and business process packages generated by users from
Software AG Designer.

Hosted packages. These are packages provided by Software AG on the Software AG
Installer, where they are listed under Integration Server on the product selection tree.
On the tree, they are listed using their product names. However, in the file system
and within Integration Server, they are listed under their package names, and those
names start with Wm. For this reason they are also called Wm packages.

Examples of hosted Wm packages are ActiveTransfer (WmMFT), Process Engine
(WmPRT), Trading Networks (WmTN), adapters, and eStandards Modules.

When you installed the new Integration Server, the Software AG Installer created a
server instance and copied all Wm packages and language packs you selected on the
product selection tree into a package repository. The installer let you choose whether
to install the selected Wm packages on the instance. (The installer always installs the
language packs you selected on the instance.)

Configurations, Data, and Assets that Can be Migrated
Server instances.

Custom (user-created) packages.

Password store, and passwords.

Integration Server configuration files.

Configuration for hosted products, such as Trading Networks.

JAAS configuration files.

JDBC connection pool configurations, database drivers, and functional aliases.

If the old Integration Server hosted Wm packages and those Wm packages also exist
on the new Integration Server, the configuration files for those packages.

Java Service Wrapper customizations you made in the old custom_wrapper.conf
files, including #include directives and comments (but not associated properties).
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Starting in 9.5, custom (user-created) jar files.

Other Actions Performed as Part of the Migration
Deletes old configuration files that are not used by the new Integration Server, and
deletes old properties that are not used by the new Integration Server from the new
configuration files.

If the old Integration Server used the embedded database, copies the database tables
from the old Integration Server to the new Integration Server and upgrades the
tables to the new format if necessary.

Updates the SERVER ID stored in Integration Server database tables and
configuration files to reflect the new host machine.

Adds a new property named "Validate schemas using Xerces" to existing
Web service descriptors, and sets the new property to the value the
wa.server.wsdl.validateWSDLSchemaUsingXerces parameter had in the old
Integration Server. The new property replaces the functionality provided by
that parameter. For information about the new property, see webMethods Service
Development Help.

If you are migrating Business Rules data, upgrades Business Rule projects. You
might see XML parsing messages due to a Java bug; you can ignore these messages.

If you are upgrading CloudStreams, migrates configuration artifacts related to
administering CloudStreams Server.

Migrate Integration Server
1. If you are upgrading an Integration Server cluster, read “ Integration Server or

Microservices Runtime Requirements” on page 26.

2. If you are upgrading an Integration Server that hosts Deployer, follow the
instructions in “Migrate the Asset Build Environment, Deployer, and Application
Platform” on page 93.

3. If the new and old Integration Servers are on the same machine, make sure the old
Integration Server is shut down.

4. The migration will scan the old installation for custom packages. However, it will
not find custom packages whose names start with Wm, as this naming convention
is used for packages provided by Software AG. If you have custom packages
whose names start with Wm, and you want to migrate them, go to the new_Software
AG_directory /IntegrationServer/bin/migrate directory, open the packages.cnf file,
and add a <value name><\value> tag that identifies those custom packages (for
example, <value name="WmFINMessages">WmFINMessages</value>).
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Note: To simplify future upgrades, and as a general best practice, do not use the
naming convention Wm name  for custom packages.

5. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below. To find the product_ID  to use in the command, run the Command Central
command sagcc list inventory products node_alias. If you want to
use a custom migration, first run the migration utility manually to create the
migrate.dat file (see “Migrate Products Using Migration Utilities” on page 127
for instructions), and then specify the migrate.dat file on the importFile
parameter.
sagcc exec administration product target_node_alias
integrationServer migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}
[importFile=full_path_to_migrate.dat ]
instanceName=name  [newInstanceName=name ]
[cloneDbURL=URL  cloneDbUser=user  cloneDbPassword=password ]

Complete the Integration Server Upgrade

Check Java Service Wrapper #include Directives
Any Java Service Wrapper #include directives are migrated to the end of
the new custom_wrapper.conf file; check them and adjust as necessary. The
custom_wrapper.conf file is located in the Software AG_directory /profiles/
IS_instance_name /configuration directory.

Note: As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf file unless instructed to do so by Software AG.
If you did so, however, manually copy values for properties you modified
in the old wrapper.conf file to the corresponding properties in the new
custom_wrapper.conf file.

Customize Integration Server Startup Files
The Integration Server startup scripts were changed in release 9.7. If you customized the
old scripts, see webMethods Integration Server Administrator’s Guide and the Integration
Server readme for instructions on how to duplicate those customizations for the new
installation.
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Update WSDLs
If you have Provider Web services that have an operation with field names starting with
xml in the input signature, output signature, header, or faults, do the following:

1. Start the new Integration Server.

2. Review the migrationLog.txt file in the new_Software AG_directory /install/logs
directory. If you see this error:
A property watt.server.xml.ncname.encode.backward.compatibility exists in 
config/server.cnf with value as true. Make sure you make the required changes 
as specified in the upgrade documentation. Not doing so could have adverse 
effects as support for this property may be dropped in a future release.

Update your WSDLs as follows:

a. Open the new Integration Server Administrator and point to the new Integration
Server.

b. Go to the Settings > Extended page. If you have the extended seing
wa.server.xml.ncname.encode.backward.compatibility and it is set to true, reset
it to false.

c. Regenerate the clients for all Provider Web services that have an operation with
field names starting with xml in the input signature, output signature, header, or
faults.

Upgrade from 9.7 or 9.8: Synchronize and Update Serial webMethods
Messaging Triggers
If you are using the new Integration Server with Universal Messaging, each
webMethods Messaging trigger with serial processing must have a corresponding
priority named object on Universal Messaging. However, each serial trigger you
migrated from your old Integration Server corresponds to a shared named object on
Universal Messaging. Create the corresponding priority named object by doing one of
the following:

If the Universal Messaging is a fresh installation (that is, it was not migrated from an
earlier release), synchronize the publishable document types with the provider using
Software AG Designer or the built-in service pub.publish:syncToProvider.

If the Universal Messaging was migrated from an earlier release, this Integration
Server is the only Integration Server that connects to Universal Messaging, and the
Shared Client Prefix property for the Universal Messaging connection alias is set to
No, disable and enable the Universal Messaging connection alias used by the trigger.

If the Universal Messaging was migrated from an earlier release, and this Integration
Server is not the only Integration Server that connects to Universal Messaging or
the Shared Client Prefix property is set to Yes, wait till the named object is fully
drained and no new documents will be sent to it, and then use Universal Messaging
Enterprise Manager to delete the named object. You may need to quiesce document
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publishers before deleting the named object. Then disable and enable the Universal
Messaging connection alias used by the trigger.

Upgrade from 10.1: Save and Synchronize an Updated Publishable
Document Type
If your solution includes publishable document types with an encoding type of protocol
buffers, you need to edit, save, and synchronize the publishable document types to
Universal Messaging while the queues of subscribing triggers are empty.

Connect Integration Server and Hosted Products to Database
Components
If you did not migrate functional aliases, database driver configurations, and JDBC
connection pool configurations, connect Integration Server and the products it hosts
(for example, Trading Networks) to their database components. For instructions, see
Installing Software AG Products.

Complete the ActiveTransfer Upgrade
If you used custom keystore files in the old ActiveTransfer installation, make sure they
are available and accessible in the location specified in the new installation.

If you have active file shares and did not configure the mft.sharing.account.tempdir
property in the old installation, go to the new_Software AG_directory /IntegrationServer/
instances/instance_name /packages/WmMFT/config directory, open the properties.cnf file,
and specify the old TempAccounts path on the mft.sharing.account.tempdir property.

When you start ActiveTransfer, it will modify listener (port) names to comply with
Command Central standards. If ActiveTransfer finds duplicate listener (port) names, it
will add an underscore and a unique number to each name. If a listener (port) name has
a white space, it will replace that white space with an underscore.

Complete the CloudStreams Upgrade
Back up any custom packages that contain CloudStreams artifacts, and then run the
public service pub.cloudstreams.migration:migrate, which is available in the
WmCloudStreams package. The service migrates old CloudStreams artifacts in custom
packages that depend on the WmCloudStreams package and updates them to be
compatible with the new CloudStreams. Artifacts include SOAP and REST connector
services and connections. The utility logs the results of migration to the Integration
Server server log.

The table below provides the input signature for the
pub.cloudstreams.migration:migrate service.
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Parameter Description

allPackages Boolean string. Optional. Set to:

true to migrate CloudStreams artifacts from all custom
packages that are dependent on WmCloudStreams.

false to migrate CloudStreams artifacts from only custom
packages specified on the packages  parameter. This is the
default.

packages Object. String array containing the names of custom packages to
migrate. You must specify at least one package name.

The output signature of the service is a parameter named Result that consists of an array
of iData records. The array contains a record for each custom package specified in the
input signature.

The table below lists the fields in each record in the array for each custom package
specified in the input signature for the pub.cloudstreams.migration:migrate
service.

Field Description

packageName String. Name of the custom package.

success String. Value that indicates whether migration succeeded (true)
or failed (false).

message String. Information about the migration, such as number of
CloudStreams artifacts found in the package and number of
CloudStreams artifacts that were successfully migrated.

info Object. Optional. If the service issued info messages during the
migration, string array of the messages.

errors Object. Optional. If the service issued errors during the
migration, string array of the errors.

Configure TLS 1.1 and 1.2 Trust Store
For SaaS back ends that have certificates that are not part of the JVM trust store, create
and apply a new JKS trust store in Integration Server with the certificates of the SaaS
back end. The trust store should contain all certificates in the certificate chain. This is a
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standard practice for seing up secure exchange of certificates. If the trust store is not
present in such cases, certificate related errors will occur.

1. In Integration Server Administrator, go to the Security > Keystore page and create the
trust store. For detailed instructions, see the section on securing communications in
webMethods Integration Server Administrator’s Guide.

Note: You can also create the trust store using a publicly available tool.

2. Apply the trust store in the connection's advanced property Trust Store Alias. For
detailed instructions, see the CloudStreams documentation for the Provider you are
using.

Complete the Dynamic Business Orchestrator Upgrade
Go to the old_Software AG_directory /IntegrationServer/instances/instance_name /packages/
WmDBO/config directory and copy the provision.cfg file to the same directory in the
new installation.

Complete Adapter Upgrades
If the old Integration Server hosted adapters, and you installed the same release or later
of those adapters on the new Integration Server, you migrated data for the adapters as
part of the Integration Server migration. For the adapters below, however, you must also
complete the indicated tasks. Then restart Integration Server.

For instructions on upgrading adapters when you are not also upgrading the host
Integration Server, see the adapter product documentation.

webMethods Adapter for JDBC
If the adapter connects to an Oracle RDBMS using an OCI driver, set the environment
variables on the new Integration Server machine.

The table below provides the environment variable seings for the listed platforms for
the Integration Server machine.

Platform Environment Variable Setting

Solaris LD_LIBRARY_PATH=\ORACLE_HOME\lib

HP SHLIB_PATH=\ORACLE_HOME\lib

AIX LIBPATH=\ORACLE_HOME\lib
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Platform Environment Variable Setting

Linux LD_LIBRARY_PATH=\ORACLE_HOME\lib

webMethods Microsoft Package
For instructions on migrating webMethods Microsoft Package to a new Integration
Server on the same host as the old Integration Server, see the product documentation.

webMethods Adapter for SAP
1. If the new Integration Server is on a UNIX system, set the environment variables on

the machine.

The table below provides the environment variable seings for the listed platforms
for the Integration Server machine.

Platform Environment Variable Setting

Linux, Solaris LD_LIBRARY_PATH

HP SHLIB_PATH

AIX LIBPATH

2. If the new Integration Server is on a Windows system, go to the C:\WINDOWS
\system32\drivers\etc directory on the old Integration Server machine, open the
services file, and copy all entries that contain the phrase "sapgw" into the same file
in the new installation. Examples of these entries are sapgw00 3300\tcp, sapgw01
3301\tcp, sapgw02 3302\tcp, sapgw03 3303\tcp, sapgw04 3304\tcp, and sapgw05
3305\tcp.

Complete eStandards Module Upgrades
If the old Integration Server hosted eStandards Modules, and you installed the same
release or later of those modules on the new Integration Server, you migrated data
for the modules as part of the Integration Server migration. For the modules below,
however, you must also complete the indicated tasks. Then restart Integration Server.

For instructions on upgrading eStandards Modules when you are not also upgrading the
host Integration Server, see the eStandards Modules product documentation.
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webMethods SWIFTNet Module
Reconfigure the module. For instructions, see webMethods SWIFTNet Module Installation
and User’s Guide.
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Migrate Software AG Designer

Before Migrating
1. Open the new Software AG Designer and point to a new workspace. For example,

you can accept the default workspacerelease  (for example, workspace912)

2. Install any third-party features you need (for example, support for Subversion). The
Eclipse release installed with the new Software AG Designer is Eclipse 4.7.3, so make
sure any features you add are compatible with that Eclipse release.

3. If you exported your preferences before upgrading, import them as follows:

a. Go to the File > Import wizard. In the Select panel, go to General > Preferences
and click Next. In the From preference file field, specify the .epf file to which you
exported your preferences. Click Finish.

b. Go to Window > Preferences. In the preferences window, go to the Java > Installed
JREs > Execution Environments page, if multiple JREs are listed, make sure JRE 1.8
is selected as the default, or remove older JREs from the list. Also update seings
that point to old product installations to point to new product installations
instead. For example, for My webMethods Server, update the Server > Runtime
Environments seings. For Application Platform, update the path to the runtime
instance, then review the messages on the Error tab to see whether any other
paths need to be updated.

c. Restart Software AG Designer.

Migrate Apama, Application Platform, Business Process, and
Business Rule Projects
1. If you are migrating Apama, copy any files you modified from the old work

directory to the new work directory.

2. If your projects are stored in a source control system, use the import wizard for that
system (for example, Import SVN > Project from SVN).

If your projects are stored in the Software AG Designer workspace, do the following:

a. Go to the File > Import wizard.

b. In the Select panel, go to General > Existing Projects into Workspace and click Next.

c. In the Import Projects panel, do the following:

a. Click Select Root Directory and go to the workspace that contains a type of
project you want to import, or click Select Archive File and go to the directory
that contains a type of project you want to import.
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b. In the Projects box, select the projects to import. Select Copy projects into
workspace. Click Finish.

3. If you are migrating Apama, use Project > Clean to force a rebuild of generated
project artifacts under the control of Software AG Designer.

4. Verify the projects.

The table below explains how to verify the projects for the listed products.

Product Verify

Apama All projects build without errors. If errors appear in the
Problems tab, click each error and resolve it.

Application
Platform

All projects compile without errors. If errors appear in the
Problems tab, click each error and resolve it. For example, if
you see errors indicating that classes cannot be resolved to a
type, edit the project’s class path configuration.

Business
Process

All imported business process projects appear in the Solutions
tab under the Processes node.

Business
Rules

All imported business rules projects appear in the Solutions
tab under the Rules node.

5. If you imported Business Rule projects, right-click each project in the Rules Explorer
and then click Upgrade Project.

6. If you are migrating Apama

a. If any project imports event types from Digital Event Services, you might need to
re-import those event types. Open the project, open the EventTypeList file under
config/connectivity/DigitalEventServices, and click Sync from Digital Event Services.
If you see changes, save the file.

b. If you use ant to automate building and deploying your projects, export your
ant deployment scripts to an empty directory. Run the scripts to force a rebuild
of any generated artifacts within your projects (for example, Apama queries,
scenarios or Java\C\C++\.NET code using Apama APIs). Review the build
output for errors and warnings.

c. If you use Apama dashboard deployments, create new deployment packages and
install the deployment packages.

Migrate Task Application Projects
1. Update your preferences.
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a. Go to Window > Preferences > Server > Runtime Environments. If the Installed server
runtimes list does not include a My webMethods Server from the new release, add
one.

b. Go to Software AG > Task Development. In the preferences window, make sure all
your other task-related Software AG Designer preferences are correct, and then
click OK.

2. Import your projects.

a. Go to the File > Import wizard.

b. In the Select panel, go to Software AG > Existing CAF Projects into Workspace and then
click Next.

c. In the Import Projects panel, click Select Root Directory and go to the workspace or
source control system that contains your task application projects, or click Select
Archive File and go to the directory that contains your task application projects. In
the Projects box, select the projects to import.

d. Select Copy projects into workspace and then click Finish.

3. Make sure all imported task application projects appear in the Solutions tab, under
the Tasks node.

4. If errors appear in the Problems tab, click the Navigator tab. Right-click each task
application project, click CAF Tools, and click Repair CAF Project. If errors still appear,
restart Software AG Designer.

5. Publish the migrated task application projects to a My webMethods Server from the
new release. For instructions, see webMethods BPM Task Development Help.

Redo Attachment List Control Customizations in CAF Applications
In 9.10, the CAF Attachments List control was improved; for example, the Java applet-
based drag and drop panel was replaced by an HTML5-based equivalent.

Your CAF applications were migrated when you ran the My webMethods Server
migration utility, but any customizations you made to the Attachments List control in
your CAF applications were not. Manually redo the customizations in the migrated CAF
applications.

Migrate CloudStreams Server Definitions and Projects
1. Go to Window > Preferences > Software AG > CloudStreams > Servers. Click Import, select

the .properties file you exported earlier, and click Open. Software AG Designer asks
whether to overwrite existing server definitions with the imported definitions. Click
OK twice.

2. Open the CloudStreams Development perspective.
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3. In the CloudStreams Governance view, right-click empty space and click Import
to open the wizard. In the Select Root Directory field, identify the directory that
contains the governance projects you exported earlier. In the Projects box, select the
governance projects to import from the exported project folder. Click Copy projects
into workspace and then click Finish. Click the Governance tab and make sure all
imported governance projects appear.

4. In the CloudStreams Providers view, right-click empty space. If you want to import
provider projects you exported to an archive (ZIP file) earlier, click Import Archive File.
If you want to import provider projects from another CloudStreams, click Import from
Workspace.

Migrate Integration Server or Microservices Runtime Definitions
1. Go to Window > Preferences. On the Preferences dialog box, in the left navigation bar,

go to Software AG > Integration Servers.

2. Click Import, select the .properties file you exported, and click Open. Software AG
Designer asks whether to overwrite existing servers. Click OK, and then click OK
again to close the Preferences dialog box.

Migrate Mobile Projects
1. Go to Window > Preferences > Software AG > Mobile Development and update the Mobile

Designer installation directory to the MobileDesigner subdirectory in your new
Software AG Designer installation directory.

2. Import your projects.

a. Go to the File > Import wizard.

b. In the Select panel, go to General > Existing Projects into Workspace and then click
Next.

c. In the Import Projects panel, click Select Root Directory and go to the workspace
that contains your mobile projects. In the Projects box, select the projects to
import.

d. Select Copy projects into workspace and then click Finish.

3. In Package Explorer, follow the steps below. For instructions on resolving issues and
errors, see Migrating Mobile Projects in webMethods Mobile Development Help.

a. Go to the model directory for each imported project and double-click the .aml
file. Check for warnings and errors and resolve any issues.

b. Right-click the root node for each imported project and then click Generate Source
Code > Application Model and API. Resolve any compile errors.

c. If you are using Mobile Administrator (instead of the Jenkins-based Remote
Multi-Build), enable the Mobile Administrator Remote-Multi-Build ant target. Go
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to the root of your project, open the build.xml file, and add the text below to the
end of the file as a single line:
<import file="${env.MOBILE_DESIGNER}/plugins/MobileAdministrator/
v1.0.0/targets.xml"/>

4. If you later have problems with Android handset targets, such as problems running
your project in the Phoney simulator, go to each project's /target directory in Package
Explorer and remove all existing handset targets. Then re-add the targets for the
project by running the ++Activate-Handset ant target.

Migrate Business Process Runtime Data

Note: If you have running process instances that are based on a process model
created before you upgraded, and you now want to regenerate that process
model in the new Software AG Designer, change the version number of the
process model to the next sequence number before regenerating it. If you
do not do so, the process instances will not behave as expected. When you
enable the new version of the process model for execution in My webMethods
Server, you will be asked if you want to upgrade running processes; respond
No.

Note: Steps for Microservices Runtime are identical to those for Integration Server.

1. If you migrated business process packages that were generated by users from
Software AG Designer, make sure the packages exist in the new_Software
AG_directory /IntegrationServer/instances/instance_name /packages directory. The
package names are the project names or custom names you specified in Software AG
Designer.

2. Open Integration Server Administrator and point to new Integration Servers
that host Process Engines. Go to the Settings > JDBC Pools page and connect the
ProcessEngine and ProcessAudit functions to their database components. For
instructions, see Installing Software AG Products.

3. In Integration Server Administrator, go to the Package > Management page and click 
for the WmMonitor package.

4. If your old and new product installations are on different machines and you want to
be able to resubmit processes and process steps that ran before you upgraded, follow
the steps below.

If the new Integration Server that hosts Monitor is connected to a messaging product
and has process model fragments, select the Resubmit to local IS check box, click
Submit, and then reload the package.

If the new Integration Server that hosts Monitor is not connected to any messaging
product and has no process model fragments, clear the Resubmit to local IS check box,
click Submit, and then reload the package.
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5. Go to the Settings > Messaging > webMethods Messaging Trigger Management page and
make sure document retrieval is enabled for all webMethods Messaging triggers
on new Integration Servers. For instructions, see webMethods Integration Server
Administrator’s Guide.

Migrate the Closed Loop Analytics JMS Topic
In “Migrate Software AG Designer” on page 80 you migrated all configurations
and data involved in Closed Loop Analytics. You must now update the JMS topic in
Universal Messaging from which Closed Loop Analytics collects escalation events, as
follows:

1. Start the Universal Messaging instance from the new release that you are using for
BPM, and then start the Enterprise Manager.

In the left panel, open the Realms tree and click the Universal Messaging instance
you are using for BPM.

In the right panel, click the JNDI tab and open the Topics tree. Delete the topic
for the escalation event type {hp://namespaces.softwareag.com/EDA/WebM/
Rules/CLA/1.0}ProcessEscalation.

2. On the Universal Messaging instance host machine, go to the new_Software
AG_directory /jvm/jvm/bin directory and open a command window or shell. Create
a new topic for the escalation event type by entering the command below. Type the
command on one line with a space at each of the line breaks shown below.
java -jar new_Software AG_directory  /common/lib/event-routing-jms-util.jar
bind nsp://locahost:9000
{http://namespaces.softwareag.com/EDA/WebM/Rules/CLA/1.0}ProcessEscalation
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Configure and Start the Terracotta Server Array
If you are clustering Analytic Engines in the new release, you must configure and start
the Terracoa Server Array. For instructions, see  Using Terracoa with webMethods
Products, Configuring BAM, and the Terracoa BigMemory Max documentation.

Update Connection to Other Products

Update Connection to Process Engine
If you are using Optimize for Process, follow the steps below.

1. Open Integration Server Administrator and point to a new Integration Server that
hosts a Process Engine.

2. Go to the Packages > Management page and click  for the WmPRT package.

3. Click Settings in the left navigation bar and then click Edit Process Engine Settings.

4. In the JMS Server URL field, identify the Universal Messaging host name and port as
nsp://host :port . The default port is 9000.

5. Click Submit and then reload the WmPRT package.

6. Repeat these steps for every new Integration Server that hosts a Process Engine.

Update Connection to Optimize Support Package
If you are using Optimize built-in services, follow the steps below.

Note: Steps for Microservices Runtime are identical to those for Integration Server.

1. Open Integration Server Administrator and point to a new Integration Server that
hosts an Optimize Support package.

2. Go to the Packages > Management page and click  for the WmOptimize package.

3. Identify the Analytic Engine host machine and port. The default port is 12503.

4. In the JMS Server URL field, identify the Universal Messaging host name and port as
nsp://host :port . The default port is 9000.

5. Click Submit and then reload the WmOptimize package.

6. Repeat these steps for every Integration Server that hosts an Optimize Support
package.
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Migrate Infrastructure Data Collector

Infrastructure Data Collector Configurations, Data, and Assets that
Can be Migrated

Asset configuration files.

SNMP, JAAS, JMX, SSH, security, log, platform debug, Web Services Stack, and
watchdog configurations.

Java Service Wrapper customizations you made in the old custom_wrapper.conf
files, including #include directives and comments (but not associated properties).

Migrate Infrastructure Data Collector
1. If the new and old Infrastructure Data Collectors are on the same machine, make

sure the old Infrastructure Data Collector is shut down.

2. If you want to migrate SNMP asset configuration files, go to the
new_Software_AG_directory infrastructuredc/bin/migrate/old_release  directory and
open the snmpMigration.properties file. Enter the full paths to the old and new
SNMP configuration directories. The contents of the file show the format to use.

3. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below. If you want to use a custom migration, first run the migration utility
manually to create the custom migrate.dat file (see “Migrate Products Using
Migration Utilities” on page 127 for instructions), and then specify the
migrate.dat file on the importFile parameter .
sagcc exec administration product target_node_alias
InfrastructureDC migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}
[importFile=full_path_to_migrate.dat ]

Complete the Infrastructure Data Collector Upgrade
#include directives are migrated to the end of the new custom_wrapper.conf file; check
them and adjust as necessary. The custom_wrapper.conf file is located in the Software
AG_directory /profiles/InfraDC/configuration directory.

Note: As noted in the Software AG Infrastructure Administrator's Guide, you should
never modify the wrapper.conf file unless instructed to do so by Software AG.
If you mistakenly modified the old wrapper.conf file, manually copy values
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for properties you modified in the old wrapper.conf file to the corresponding
properties in the new custom_wrapper.conf file.

Deploy the Optimize Environment
Unless otherwise noted, see Configuring BAM for detailed instructions on the Optimize
steps in the sections below.

Not Reuse the Old Optimize CCS Environment Definition
If you do not want to reuse your old Central Configurator System (CCS) Environment
definition, start the new My webMethods Server, open My webMethods, and configure
your new Optimize environment.

For Infrastructure Data Collector, when you define hosts, enter the same value in the
Host Name or IP Address field of the Add\Edit Host dialog box that you had in the old
release.

Note: If the new value is not identical to the old value, you will have to stop
monitoring existing assets, rediscover them, and reselect them for monitoring
after you finish upgrading.

Skip to the step for deploying the new Optimize environment, below.

Reuse the Old Optimize CCS Environment Definition
To reuse the old CCS environment definition that you exported to file before installing
the new Optimize, follow the steps below.

1. Start the new My webMethods Server and open My webMethods.

2. Import the old CCS environment, as follows:

a. Go to the Applications > Administration > System-Wide > Environments > Define
Environments page.

b. Click Import Environment. On the Import Environments dialog box, click Browse,
go to the file to which you exported the old CCS environment, and click OK.
When prompted, confirm the migration.

c. When asked "Do you wish to migrate the environment to the latest version?",
click Yes. The CCS imports the old environment and migrates it to the new
Optimize Logical Servers.

3. Update the database pool connection seings for the database pool definition
associated with the environment you imported, as follows:

a. Go to the Applications > Administration > System-Wide > Environments > Database Pool
Configuration page.
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b. In the Pool column, click the imported database pool.

c. In the Pool Settings area, set the Minimum Connections field to 8, and the Maximum
Connections field to 60.

d. Make sure the database connection information is correct. In the Database
Connection area, click Test and make sure the message Test Passed displays at
the boom of the page.

e. Click Save.

4. Go to the Applications > Administration > System-Wide > Environments > Define Environments
page. Under Environment Name, click the environment you imported.

5. If you are using a different JMS provider with the new release than you used with
the old release, do the following:

a. Click the Configure Servers tab. Under Configuration, open the Default Settings tree
and click JNDI Configuration.

b. In the Naming Factory Type list, click the JMS provider you are using with the new
release (Universal Messaging) and clear the Broker Name field. Click Save

c. Click the Map Endpoints tab. In the first Incoming Connections field for the JMS
Provider, type nsp for Universal Messaging. In the second field, type the port
number.

d. Click Save.

6. Validate the environment as follows:

a. Click each tab that shows a red circle except the Validate tab. If you change any
seings on a tab, and the tab has a Save buon, click Save.

b. When all tabs except the Validate tab show a green check mark, click the Validate
tab.

7. Click Finish.

Deploy the New Optimize Environment
1. Start the new Optimize components you installed. These components can include the

Analytic Engine, Infrastructure Data Collector, and the Web Services Data Collector.

2. Start the Universal Messaging you are using with the new release.

3. Deploy your new Optimize environment. For instructions, see Configuring BAM.

4. In My webMethods, go to the My webMethods > System Settings > Servers page.

If you have BPMS installed, select the BPM and BAM option and identify the new
Analytic Engine and the new Integration Server that hosts Monitor. For the hosts,
you can specify DNS name or IP address.
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If you have BPMS installed, but are not using BPM (that is, you are using only
Optimize), select the BAM only option and identify the new Analytic Engine. For
the host, you can specify DNS name or IP address.

5. Start the Analytic Engine and then click Check Server Status to make sure the server is
available (green icon). It might take some time for the server to start (for example, 15
minutes). Then click Save.

Upgrade from 9.7: Start Monitoring 4.1 or Later Terracotta
Server Arrays
For instructions on each step, see Administering webMethods Optimize.

1. Start the new Infrastructure Data Collector.

2. Go to Applications > Administration > Infrastructure Components > Discovery.

3. Delete all Terracoa (Asset) entries.

4. Rediscover 4.1 or later Terracoa Server Arrays you want to monitor.

5. Go to Applications > Administration > Infrastructure Components > Monitored Components.
Select Terracoa Server Array monitors, components, and KPIs.

Switch from webMethods Broker to Universal Messaging
If you use webMethods Broker as your JMS provider in the old release, and are going to
use Universal Messaging in the new release, do the following:

1. Start Universal Messaging and open Universal Messaging Enterprise Manager.

2. Connect to a Universal Messaging instance, then click it.

3. Click the Config tab. Expand Global Values and set AllowRealmAdminFullAccess to
true.
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Migrate the Asset Build Environment
Go to the old_Software AG_directory /common/AssetBuildEnvironment/master_build
directory and copy the build.properties file to the same location in the new installation.

Migrate Deployer

Configurations, Data, and Assets that Will be Migrated
Seings.

Server aliases.

Target groups.

Projects.

Note: Migrating Deployer projects does not convert the product assets in those
projects from their old release to the new release. You must migrate the
assets as instructed earlier in this guide.

Migrate Deployer
1. Upgrade all source and target product servers that were defined in the old Deployer

to the new release, and migrate all configurations, data, and assets for those products
to the new release, as instructed earlier in this guide.

2. If the new and old Deployer are on the same machine, make sure the old Deployer is
shut down.

3. You migrate Deployer when you migrate the host Integration Server. Do not start
the new host Integration Server before you migrate Deployer. If you do, a file named
MIGRATION_DONE will be created in the WmDeployer package, and you will not
be able to perform the migration. If you did start the new host Integration Server,
delete this file.

4. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions for Integration
Server in “Migrate Products Using Migration Utilities” on page 127.

To migrate using Command Central, follow the instructions for Integration
Server in “Migrate Integration Server, Microservices Runtime, and Hosted Wm
Packages” on page 69.
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Migrate Application Platform

Application Platform Configurations, Data, and Assets that Will be
Migrated

Application Platform configuration files that reside in Integration Server
installations.

Application Platform projects bundles that reside in My webMethods Server
installations.

Upgrade from 9.8, 9.9, 9.10, or 9.12: Web applications that were created using
WmTomcat for use as Application Platform web applications. Each web
application will be migrated as a war ZIP file to the new_Software AG_directory /
profiles/instance_name /workspace/webapps directory.

Migrate Application Platform
1. If the new and old Integration Server instances that host the Application Platform

Support package are on the same machine, make sure the old instances are shut
down.

2. If the new and old My webMethods Server instances that host Application Platform
projects bundles are on the same machine, make sure the old instances are shut
down.

3. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below.
sagcc exec administration product target_node_alias
PLSCore migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}

Complete the Application Platform Upgrade

Verify and Correct Package Imports
Go to the new_Software AG_directory /install/log directory and open the migrationLog.txt
file. Check for messages similar to this message:
Project bundle /dev/installs/99oct2015/profiles/IS_default/
workspace/app-platform/deployer/bundles/greeter-web.jar
contains a package com.softwareag.applatform.sdk with import version
range [start_version , end_version ) that must be upgraded manually.
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The message relates to semantic versioning of the packages used in your Application
Platform projects. For information, see the OSGi Alliance semantic versioning technical
whitepaper.

If the message exists, and you never created manifest files for Application Platform
projects, rebuild and redeploy the projects using Asset Build Environment and
Deployer.

If the message exists, and you did create manifest files for Application Platform projects,
edit the manifest files to include the end_version , and then rebuild and redeploy the
projects.

For instructions on rebuilding and redeploying Application Platform projects , see
webMethods Application Platform User’s Guide.

Update the Tomcat Configuration
1. Go to old_Software AG_directory /IntegrationServer/web/conf directory and open all

configuration files in that directory in a text editor.

2. Go to new_Software AG_directory /profiles/instance_name /configuration/tomcat/conf
directory and open all configuration files in that directory in a text editor.

3. Go to “hps://tomcat.apache.org/migration-85.html”.

4. Using the instructions on the web page, modify the new configuration files to have
the same custom changes you made in the old configuration files.

5. Go to the new_Software AG_directory /profiles/instance_name /configuration/tomcat/
conf directory, open the server.xml file, and replace the existing <Realm> element
with the following:
<Realm className="org.apache.catalina.realm.LockOutRealm">
  <Realm className="com.softwareag.platform.catalina.auth.SINRealm"
     name="AppPlatformRealm"     
     userClassNames="com.softwareag.security.jaas.principals.SagUserPrincipal"     
     roleClassNames="com.softwareag.security.jaas.principals.SagRolePrincipal"     
     defaultRealm="AppPlatformRealm"/>
</Realm>

Upgrade from 9.8, 9.9, 9.10, or 9.12: Complete the WmTomcat Web Applications
Migration
1. Remove the dependency of each web application on WmTomcat. For each migrated

Integration Server package, go to thenew_Software AG_directory /IntegrationServer/
instances/instance_name /migrated_package  directory, open the manifest.v3 file in a
text editor, remove the line below, and then save the file.
<value name="WmTomcat">...</value>

2. The URL for the migrated web applications is different from the URL for the original
web applications; the port number changes, and the /web segment is removed (for
example, the old URL hp://localhost:5555/web/MyPackage/index.jsp becomes

https://tomcat.apache.org/migration-85.html
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hp://localhost:8072/MyPackage/index.jsp). Notify your users and update your
software components that depend upon the URL.

3. Each web application was migrated as a war ZIP file. If you want to reduce the time
it takes the Tomcat servlet container to start, go to the new_Software AG_directory /
profiles/instance_name /workspace/webapps directory and extract the war files from
each ZIP file into the webapps directory.

4. If you have direct calls to the Integration Server API
com.wm.app.b2b.server.Service.doInvoke( ) in the JSP page for a web application, replace
them with <webm:invoke/> custom tags. For instructions, see the Application
Platform documentation.
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15   Migrate Apama

1. If the new and old Apama are on different machines, update deployment scripts (for
example, ant scripts and properties files) to specify the correct host names for the
new installation.

2. If the new and old Apama are on the same machine, make sure all processes from
the old installation are shut down.

3. Run your ant scripts to force a rebuild of any generated artifacts within your projects
(for example, Apama queries, scenarios or Java\C\C++\.NET code using Apama
APIs). Check the build output for errors and warnings.

4. Inject your migrated applications into the new Apama by running them in your user
acceptance testing (UAT) environment. Scan the correlator logs for any errors or
warnings. Re-run all your system tests (for example, PySys test cases) and ensure
your application behaves as expected.

5. If you are using Command Central, recreate Apama instances in the new installation
using the same command line, GUI, or composite template procedure you used to
create the instances in the old installation, with modifications to accommodate any
deprecated or removed items mentioned in the Apama release notes.



M
Even Header

Upgrading Software AG Products Version 10.3 100



M
Odd Header

Migrate API Gateway, API Portal, and CentraSite

Upgrading Software AG Products Version 10.3 101

16   Migrate API Gateway, API Portal, and CentraSite

■   Upgrade from 10.1: Migrate API Gateway .................................................................................    102

■   Migrate API Portal ......................................................................................................................    103

■   Migrate CentraSite .....................................................................................................................     104



M
Even Header

Migrate API Gateway, API Portal, and CentraSite

Upgrading Software AG Products Version 10.3 102

Upgrade from 10.1: Migrate API Gateway

API Gateway Configurations, Data, and Assets that Will be Migrated
Event Data Store (see “Upgrade from 10.1: Prepare the Old API Gateway” on
page 37).

Configurations for the old Integration Server that hosts API Gateway, the API
Gateway UI and dashboard (Kibana), and for one API Gateway instance.

Migrate API Gateway

Note: Event Data Store was renamed Internal Data Store in release 10.2.

1. If the new and old API Gateway are on the same machine, make sure the old API
Gateway (and its host Integration Server) are shut down.

2. If you used custom keystore files in the old API Gateway installation, copy the files
to the same location in the new installation.

3. To update the connection seings and default mappings for the Internal Data Store
in API Gateway, start the new API Gateway, log on, start the Internal Data Store, and
then shut down API Gateway.

4. Start the new Internal Data Store by starting the service Software AG Internal
Data Store or by opening a command window or shell, going to the new_Software
AG_directory /InternalDataStore/bin directory, and running the command
startup.bat

5. Go to the new_Software AG_directory /IntegrationServer/
instances/instance_created_during_installation /packages/WmAPIGateway/bin/migrate
directory, open a command window or shell, and run the command below.
migration.{bat|sh}
–instanceName name_of_old_API Gateway_instance
-edsbackup full_path_to_-backupDestinationDirectory /default
-isbackup full_path_to_-backupDestinationDirectory

6. In addition to checking the standard upgrade log migrationLog.txt file in
the new_Software AG_directory /install/logs directory, see the console.log
and Reports*.html logs in the new_Software AG_directory /IntegrationServer/
instances/instance_name /packages/WmAPIGateway/bin/migrate directory.

7. Shut down the new Internal Data Store, then restart API Gateway and theInternal
Data Store.
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Migrate API Portal

API Portal Assets that Can be Migrated
Users and user groups.

APIs and API documents.

Plans and packages.

Apps and applications.

Collaboration data.

Upgrade from 10.1: Analytics data.

Migrate API Portal
1. If the new and old API Portals are on the same machine, make sure the old API

Portal is shut down.

2. If you installed the new API Portal in a clustered, high-availability setup, make sure
all nodes are running and accessible to the Zookeeper ensemble. Then register all the
nodes with the parent node by invoking the REST service shown below. The default
for the cloud agent port is 18009.

The table below provides details about the REST service.

Parameter Value

End point hp://load_balancer_host :load_balancer_port /acc/rest/nodes/

Method type POST

Content type application/json

Payload
{"nodename": "host_name ", "hostname": "host_name ",
 "port": "cloud_agent_port ", "username": "Clous",
 "password": "g3h31m“}

3. Start the new API Portal Cloud Controller.

4. Run this command:
acc> startall

5. For each tenant in the old API Portal, create a corresponding tenant in the new
API Portal and then import the license for the new tenant. For instructions, see
webMethods API Portal Administrator’s Guide.
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6. For each new tenant you created, restore the data for the corresponding old tenant
into the new API Portal from the backup file you created earlier by running the
commands below. Each file has the file extension .acb.

Important: Inform API Portal users that they cannot work on the tenants during the
restoration process.

Important: If the new tenant contains any data, the data will be replaced by the data
you restore from the old tenant. Only the user metadata will be merged.

The table below explains how to restore each old tenant’s data into the new API
Portal for each old product release.

For Run these commands...

9.7
9.8
9.9
9.10
9.12

acc> set acc config backup.restore.tenant.app.types = UMC, ABS, ADS, ECP
acc> restore tenant tenant_name  from full_path_to_backup_file
username=your_user_name  password=your_password
acc> invoke prepareTenant on bundle_runnable_name  tenant.name=tenant_name

10.1
10.2
10.3

acc> restore tenant tenant_name  from full_path_to_backup_file
username=your_user_name  password=your_password
acc> invoke prepareTenant on bundle_runnable_name  tenant.name=tenant_name

7. Run these commands:
acc> stop bundle_runnable_name
acc> start bundle_runnable_name

Complete the API Portal Upgrade
If you created a customized view of your old API Portal, you backed up the view. For
instructions on restoring the customized view from the backup, see the backup and
restore section in the webMethods API Portal Customization Guide.

Migrate CentraSite

CentraSite Configurations that Will be Migrated
Configurations from the old CentraSite and assets are migrated from the old Registry
Repository to the new CentraSite installation.

LDAP configuration is transformed and migrated from the old Registry Repository
to the new CentraSite JAAS configuration.
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Migrate CentraSite
Import configurations and assets from the ZIP file you created earlier. Open a command
window or shell, go to the new_Software AG_directory /CentraSite/utilities directory, and
run this command:
sbsImport.{cmd|sh} /full_path_to_ZIP_file

For example:
./sbsImport.sh /tmp/sbs_cs82_data.zip

Complete the CentraSite Upgrade
1. Start the new CentraSite.

2. If you use single sign-on with CentraSite, do the following:

a. Open the jaas.config file in the old and new Software AG_directory /profiles/CTP/
configuration directories. Copy the following from the old file to the new file:

ServletHeaderLoginModule for extracting the user ID from the incoming
HTTP header.

SimpleNameMappingLoginModule, if you are using it.

Any other entries you are using to process the extracted user ID.

The new jaas.config file should look like this:
CentraSite {
com.softwareag.centrasite.security.cache.ShortTermTokenLoginModule sufficient;
 com.softwareag.security.jaas.login.internal.InternalLoginModule sufficient
 ...
 com.softwareag.security.sin.is.ldap.lm.LDAPLoginModule sufficient
 ...
 com.softwareag.security.jaas.login.modules.ServletHeaderLoginModule 
required
 ... com.softwareag.security.jaas.login.modules.SimpleNameMappingLoginModule 
required
 ...
 com.softwareag.security.sin.is.ldap.lm.LDAPLoginModule required
 ...
};

The ShortTermTokenLoginModule establishes delegated authentication
in CentraSite to perform secured internal communication. The initial
InternalLoginModule is normally only for users in the INTERNAL domain, and
the initial LDAPLoginModule is for LDAP users that are logging in directly and
not via single sign-on. If you need only single-sign on logins, you can remove the
initial InternalLoginModule and LDAPLoginModule.

b. Set up your LDAP configuration to resolve the extracted user ID via LDAP.
Modify the generated LDAP login module to enable single sign-on-related
options, such as technical user. Apply LDAP single sign-on technical user
credentials if necessary.
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3. Change any seings in CentraSite Control that you noted earlier.

4. If you installed plug-ins that are GUI extensions for CentraSite Control in the old
CentraSite installation, install them in the new CentraSite installation.

5. If you are using API Portal with CentraSite, republish all API Portal instances you
created in the old release to the new API Portal. For instructions, see the CentraSite
documentation.
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Note: There is no direct path from Presto 3.8 (webMethods release 9.7), Presto
3.9 (webMethods release 9.8), or MashZone NextGen 9.9 to MashZone
NextGen 10.3. Instead, you must upgrade to MashZone NextGen 9.10 using
the instructions in the 9.10 upgrade guide, and then upgrade from 9.10 to
MashZone NextGen 10.3 using the instructions in this guide.

Note: MashZone NextGen was renamed MashZone NextGen Business Analytics in
release 9.12, then renamed MashZone NextGen in release 10.1.

Upgrade from 10.1 or 10.2: Migrate MashZone NextGen

MashZone NextGen Configurations, Data, and Assets that Can be
Migrated

Database you were using for the old repository. If you used the embedded Derby
database, the utility migrates the database. If you used an external database, the
utility migrates the database driver, the MashZone NextGen repository libraries, and
the database.

LDAP configuration.

User-defined custom look and feel.

User-defined custom widgets.

RAQL user-defined functions (UDFs) that are stored in the old_Software
AG_directory /MashZoneNG/raql-udfs directory.

Data file you defined and stored in the old_Software AG_directory /MashZoneNG/
mashzone/data/resources directory.

Upgrade from 10.1 Digital Event Services configuration stored in the old_Software
AG_directory MashZoneNG/apache-tomcat/conf/DigitalEventServices directory.

Upgrade from 10.2: Digital Event Services configuration stored in the old_Software
AG_directory MashZoneNG/rtbs/conf/DigitalEventServices directory.

Ehcache aribute information that you changed in the old installation.

Properties required to keep the new installation running properly. Port values are
not migrated.

Migrate MashZone NextGen
1. If you stored data files in a directory other than the default (that is, old_Software

AG_directory /MashZoneNG/mashzone/data/resources) and you want to migrate
those data files, move them into the default directory.
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2. If you stored RAQL UDFs in a directory other than the default (that is, old_Software
AG_directory /MashZoneNG/raql-udfs) and you want to migrate those UDFs, move
them into the default directory.

3. If the new and old MashZone NextGens are on the same machine, make sure the old
MashZone NextGen is shut down.

4. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below.
sagcc exec administration product target_node_alias
Presto migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}

Complete the MashZone NextGen Upgrade
Before you start MashZone NextGen, do the following if necessary:

If you changed the MashZone NextGen startup files in the old installation and you
want to re-use them in the new installation, go to the old_Software AG_directory /
MashZoneNG/apache-tomcat/bin and copy the files to the same location in the
new installation. If the files specify absolute paths, update the paths to point to the
correction locations in the new installation.

The old presto.config file references custom files such as truststores, keystores,
and the landingpage welcometext file. If you changed these references or the
referenced files in the old installation, go to the new_Software AG_directory /
MashZoneNG/apache-tomcat/webapps/mashzone/WEB-INF/classes directory, open
the presto.config file, and check whether the referenced files are available in the new
installation. If they are not, make them available.

Upgrade from 10.2: Starting in MashZone NextGen 10.3, aggregation seings
for measure columns in dashboards that use PPM Context are managed and
stored differently than they were in 10.2. You can view the dashboards in the new
MashZone NextGen, but if you want to edit a dashboard, you must first migrate it to
the new release.

1. Choose to edit a dashboard. MashZone NextGen opens a prompt dialog box
that asks whether to migrate the dashboard; click Yes. MashZone NextGen then
opens a configuration dialog box; if a measure column was assigned multiple
times, using different aggregation seings, MashZone NextGen keeps only one
instance of the measure column. Click OK on the prompt dialog box, then click
OK on the configuration dialog box.

2. MashZone NextGen shows the dashboard again in edit mode. Open the data
assignment for each widget. Reassign existing measure columns and set the
required aggregation. Re-create any duplicate measure columns that were
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removed; use a unique column name for each assignment and set the required
aggregation.

3. As a safety precaution, save the migrated dashboard under a new name. When
you are sure it is correct, you can delete the original dashboard.

In “Migrate Event Infrastructure” on page 123, you will run the Event Routing
migration utility. After that migration is complete, start MashZone NextGen and open
the Admin Console, and do the following if necessary:

The MashZone NextGen migration utility migrated standard file resources to the
new installation. Go to File resources > File resources , edit the resources entry, and set
the Path field to new_Software AG_directory /MashZoneNG/mashzone/data/resources
directory.

The Event Routing migration utility migrated the Event Type Store. If you are using
custom event types, go to Event Service > Event Service, click the EDA tab, click the
Event Type Store buon, and set the Event Type Store directory field to new_Software
AG_directory /common/EventTypeStore.

Upgrade from 9.10 or 9.12: Migrate MashZone NextGen
Set up the new MashZone NextGen to use the old repository. If you deployed extensions
to features of the old product, you will also copy the extensions to the new MashZone
NextGen installation.

Set Up the MashZone NextGen Repository

Set Up Repository When Using the Embedded Derby Database
If you used the embedded Derby database for your old repository, follow the
instructions below.

1. The new MashZone NextGen comes with a pre-populated Derby repository. Go
to the new_Software AG_directory /MashZoneNG/apache-tomcat/bin and rename
the mashzonenextgenrepository directory (for example, rename the directory
mashzonenextgenrepository_orig).

2. Upgrade from 9.10 or 9.12: Go to the old_Software AG_directory /MashZoneNG/
apache-tomee-jaxrs/bin directory and copy the mashzonenextgenrepository and
mashzonerepository directories to the new_Software AG_directory  /MashZoneNG/
apache-tomcat/bin directory.

3. Execute Derby database update SQL commands for the new release. You can execute
these commands using any SQL client that can connect to Derby, or you can use the
Derby IJ utility delivered with MashZone NextGen, as follows:

a. Open a command window and change to the directory where the Derby
database resides (for example, cd new_Software AG_directory /MashZoneNG/
apache-tomcat/bin).
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b. Start the IJ utility by running this command:
java -jar SAG_HOME/MashZoneNG/prestorepository/derby/lib/derbyrun.jar ij

c. Connect to the embedded Derby database by running this command:
connect 'jdbc:derby:mashzonenextgenrepository';

d. Run the file using the RUN command. For example:
RUN 'new_Software AG_directory /MashZoneNG/upgrade/10.1/MIGRATE-quartz2-DERBY.sql';

e. Exit the IJ utility by running the command EXIT;

Set Up Repository When Using Any Other Database
If you used MySQL, Oracle, PostGres, or SQL Server for your old repository, follow the
instructions below.

1. Go to the old_Software AG_directory /{Presto|MashZoneNG}/apache-tomee-jaxrs/
lib directory and copy the JDBC driver jar file for your RDBMS to the new_Software
AG_directory /MashZoneNG/apache-tomcat/lib directory.

The table below lists the JDBC driver jar file to copy for each type of database.

Database JDBC Driver Jar File

MySQL mysql-connector-java-5.1.31.jar

Oracle ojdbc6.jar

PostGres postgresql-9.2.1004.jdbc4.jar

SQL Server jtds-1.3.1.jar

2. If you used MySQL, Oracle, or SQL Server for the old product, do the following:

a. Go to the new_Software AG_directory /{Presto|MashZoneNG}/apache-tomcat/
webapps/mashzone/WEB-INF/lib directory and delete the jackbe-presto-rds-
postgre-derby-10.3.jar file.

b. Go to the new_Software AG_directory /{Presto|MashZoneNG}/prestorepository
directory and copy the jackbe-presto-rds-oracle-mysql-mssql-10.3.jar file to the
new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/mashzone/
WEB-INF/lib directory.

3. Configure the new MashZone NextGen to use the existing repository. For
instructions, see MashZone NextGen Administration Guide, and then see the section
on geing started with MashZone NextGen, and then see the section on moving the
MashZone NextGen repositories to a robust database solution. Skip steps 1 through
4, and start with step 5.
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Note: In MashZone NextGen 10.0 and earlier, repository connection information
was defined in the apache-tomee-jaxrs/conf/tomee.xml file. In the new
MashZone NextGen release, repository connection information was moved
to the apache-tomcat/conf/context.xml file and the format has changed.

4. Execute database update SQL commands for the new release. Use a SQL client
that is connected to your mashzonenextgenrepository. If you need help, contact
Software AG Global Support.

a. Go to the new_SoftwareAG_directory /MashZoneNG/upgrade/10.1 directory and
open the appropriate database_type .xml file in a text editor.

b. Read the instructions in the file and modify SQL statements that remove existing
constraints as necessary.

c. Execute the SQL statements in the file one by one.

Upgrade from 9.10: Add Data from Old Repository to New Repository
MashZone NextGen 9.10 had two repositories, mashzonerepository and
mashzonenextgenrepository. Starting with MashZone NextGen 9.12, there is only one
repository, mashzonenextgenrepository. The new mashzonenextgenrepository already
contains the data from the old mashzonenextgenrepository, but you must manually add
the data from the old mashzonerepository.

1. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/conf directory
and open the context.xml file. Add a <Resource> entry that sets the connection
aributes properly for the old mashzonerepository. For example:
<Resource name="amzDatabase" auth="Container" type="javax.sql.DataSource"
  maxTotal="200"
  maxIdle="30"
  maxWaitMillis="10000"
  validationQuery="values(1)"
  username="app" 
  password="app" 
driverClassName="org.apache.derby.jdbc.EmbeddedDriver"
  url="jdbc:derby:
${catalina.base}/bin/mashzonerepository"/>

2. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/
mashzone/WEB-INF directory, open the web.xml file in a text editor, and add this
XML <resource-ref> element to the boom of the file, just before the closing </
web-app> tag:
<resource-ref>
        <description>DB Connection</description>
        <res-ref-name>amzDatabase</res-ref-name>
        <res-type>javax.sql.DataSource</res-type>
        <res-auth>Container</res-auth>
</resource-ref>

3. Start the MashZone NextGen server.
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Data from the amzDatabase will automatically be migrated into the
mashzonenextgenrepository, and amzDatabase will no longer be used.

4. Shut down the server.

5. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/webapps/
mashzone/WEB-INF directory and open the web.xml file in a text editor. Remove the
<resource-ref> element you just added and save the file.

6. Go to the new_Software AG_directory /MashZoneNG/apache-tomcat/conf directory
and open the context.xml file. Remove the <Resource id="amzDatabase"> element
and save the file.

Update the MashZone NextGen Configuration and Copy Extensions
Most of the MashZone NextGen configuration is stored in the MashZone NextGen
repository. This section explains how to copy the parts of the old configuration that were
not maintained in the repository, including extensions such as custom security profiles
that you deployed in the old product. The procedure varies depending on whether you
used an external configuration directory with the old product.

Update When an External Configuration Directory Was Used
1. Update the classpath in the application server that hosts the new MashZone

NextGen to work with the external configuration directory and any subdirectories.
For instructions, see the topic on seing up an external configuration directory in the
MashZone NextGen Administration Guide.

2. Manually migrate the changes you made in the old configuration files listed below
from the old product to the corresponding files in the new MashZone NextGen.
Because of the complexity of the configuration, the easiest method is to use the
difference tool offered by many text editors.

All files listed in the topic on configuration files that must be internal in
MashZone NextGen Administration Guide.

The userRepositoryLdap.properties file, located in the external configuration
directory.

Update When No External Configuration Directory Was Used
1. Copy any extensions you deployed from the old product to the corresponding

directory for the new MashZone NextGen. See the MashZone NextGen Administration
Guide for a complete list of extensions you might need to copy.

2. Manually migrate the changes you made in the old configuration files listed below
from the old product to the corresponding files in the new MashZone NextGen.
Because of the complexity of the configuration, the easiest method is to use the
difference tool offered by many text editors.
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All files listed in the section on configuration files that must be internal in
MashZone NextGen Administration Guide.

The userRepositoryLdap.properties file, located in the old_Software AG_directory /
{Presto|MashZoneNG}/apache-tomee-jaxrs/webapps/mashzone/WEB-INF/
classes directory.

Upgrade from 9.10: Migrate Feeds and Run Upgrade Commands
1. Data feeds that were created with the 9.10 MashZone Feed Editor are not supported

in MashZone NextGen 9.12 and later. If you want to use these data feeds you must
export them from the old installation and then import them into the new installation.
For instructions on exporting and importing data feeds, see the MashZone NextGen
Administration Guide.

2. If the MashZone NextGen server is not running, start it.

3. Open a command window or shell, go to the new_Software AG_directory  /
MashZoneNG/prestocli/bin directory, and run this command:
./padmin.bat runRequestFile -u Administrator -c -w manage
-f ../../upgrade/9.12/upgrade_9.12.0.jump.txt
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18   Upgrade from 9.7, 9.8, or 9.9: Migrate Mobile
Designer

If you created apps using the Mobile Development perspective in Software AG Designer
and want to continue to do so, or if you created apps using Mobile Designer but want to
use the Mobile Development perspective in Software AG Designer from now on, delete
the environment variable MOBILE_DESIGNER as instructed below.

If you created apps using Mobile Designer and want to continue to do so,
and if you also want to continue to use your existing build environment
(that is, an IDE other than Software AG Designer, or Jenkins), delete the
MOBILE_DESIGNER environment variable as instructed below. Then pass the property
#Denv.MOBILE_DESIGNER=full_path_to_Mobile Designer to Ant when calling
Mobile Designer Ant targets (for example, enter ant #Denv.MOBILE_DESIGNER=C:
\SoftwareAG\MobileDesigner +Multi-Build).

To delete the MOBILE_DESIGNER environment variable, do the following:

For Windows, go to the Control Panel, click System, and then click Advanced
System Settings. On the Advanced tab, click Environment Variables and delete the
MOBILE_DESIGNER environment variable. Then restart your system.

For Mac OS X, delete the MOBILE_DESIGNER environment variable from
your .bash_profile, your \etc\launchd.conf file, or both. The file or files that contain
the environment variable depend on the version of MAC OS X you are using, and on
modifications you might have made. Then restart your system.
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OneData Configurations, Data, and Assets that Will be
Migrated

Configuration data.

Migrate OneData
1. If the new and old OneDatas are on the same machine, make sure the old OneData is

shut down.

2. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below.
sagcc exec administration product target_node_alias
ODE migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}

Complete the OneData Upgrade
If you customized the old OneData Java Service Wrapper, copy the customizations
from the old custom_wrapper.conf files to the new custom_wrapper.conf file. The
files are located in the Software AG_directory /profiles/ODE/configuration directory.

Note: As noted in the Software AG Infrastructure Administrator's Guide, you
should never modify the wrapper.conf file unless instructed to do so
by Software AG. If you mistakenly modified the old wrapper.conf file,
manually copy values for properties you modified in the old wrapper.conf
file to the corresponding properties in the new custom_wrapper.conf file.

If you are using JMS with OneData, copy the client jar files you backed up earlier
to the new_Software AG_directory /profiles/ODE/webapp/onedata/WEB-INF/lib
directory.

If you are using Kerberos authentication with OneData, reconfigure it using
the backups of the web.xml, server.xml, jaas.config, custom_wrapper.conf and
com.softwareag.jaas.realm.pid-SSO_realm_name .properties files you created earlier.
For instructions, see Administering webMethods OneData.

Go to the new_Software AG_directory /profiles/ODE/configuration/
com.softwareag.platform.config.propsloader directory. Open the three
com.softwareag.catalina.resource.pid-onedataschema Db1.properties files, where
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schema  is md, wa, or ra. Replace values for database parameters such as maxIdle,
maxActive and maxWait with the values you noted earlier from the old installation.
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Zementis Predictive Analytics Assets that Will be Migrated
The Zementis Predictive Analytics migration script described below will migrate
Zementis Predictive Analytics models and resources.

Migrate Zementis Predictive Analytics
1. If the new and old Zementis Predictive Analytics servers are on the same machine,

make sure the old Zementis Predictive Analytics server is shut down.

2. If the old and new installations are on different machines, copy the adapa-
backup-yymmdd -hhmmss  directory from the old installation to the machine that
hosts the new installation.

3. Go to the new_Software AG_directory /Zementis/adapa-app/migration directory.

4. Restore Zementis Predictive Analytics models and resources by running this
command:
./migration.sh restore Zementis_host_URL admin_user admin_password
full_path_to_ adapa-backup-yymmdd -hhmmss_directory



M
Odd Header

Migrate Event Infrastructure

Upgrading Software AG Products Version 10.3 123

21   Migrate Event Infrastructure

■   Migrate Digital Event Services ...................................................................................................     124

■   Migrate Event Routing ...............................................................................................................     124

■   Migrate Event Persistence Services ..........................................................................................     126



M
Even Header

Migrate Event Infrastructure

Upgrading Software AG Products Version 10.3 124

Migrate Digital Event Services
Digital Event Services components are automatically installed with products, except for
Microservices Runtime. These components are the Digital Event Services runtime and
the Digital Event Services Type Repository.

Digital Event Services Configurations, Data, and Assets that Will be
Migrated

Digital Event Services runtime configurations for all products.

Digital Event Services Type Repository.

If you used Digital Event Persistence to persist events, the service configurations.

Migrate Digital Event Services
1. Make sure none of the new products are running.

2. You can migrate using either of two methods.

To migrate using the migration utility, follow the instructions in “Migrate
Products Using Migration Utilities” on page 127.

To migrate using Command Central, use the Command Central command
below.
sagcc exec administration product target_node_alias
DEVRuntime migration migrate
{srcDir|srcFile}=full_path_to_{old_Software AG_directory|ZIP file}

Complete the Digital Event Services Upgrade
The Digital Event Services truststore and keystore configurations might contain
references to external resources. If those resources are in different locations in relation to
the new installation, go to the new_Software AG_directory /profiles/product/configuration/
DigitalEventServices/truststores and keystores directories, respectively, open the
configuration files in a text editor and update the references. The references are specified
on the location field.

Migrate Event Routing
Event Routing components are automatically installed with products.
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Event Routing Configurations, Data, and Assets that Will be Migrated
Event Type Store.

Upgrade from 9.9 or later: Event Routing configurations for all products.

Migrate Event Routing
Event Routing does not support migration from Command Central.

1. Make sure none of the new products are running.

2. To migrate using the migration utility, follow the instructions in “Migrate Products
Using Migration Utilities” on page 127.

Complete Event Routing Upgrade
Go to the new_Software AG_directory /install/log directory and open the migrationLog.txt
file. If you see the message below for one or more products, events that were delivered
to those products in the old installation were not acknowledged before the products
were shut down.
WARNING: There are still events left in IP storage location_of_old_storage_file .
These events will not be migrated automatically and will not be redelivered by
Event Routing in the new installation. For information how to migrate these
events manually, see the upgrade guide.

To enable Event Routing to deliver the events to products in the new installation,
you must copy the old storage files to the new installation. For each message, do the
following:

If the message provides the full path to the old storage file, the old storage file is
in the default location (that is, the new_Software AG_directory /profiles/product /
configuration/event/routing/runtime/storage directory). Copy the old storage file to
the same location in the new installation directory.

If the message identifies the old storage file (for example, c:\EventRoutingStorage
\SomeName_Reliable.mem) but does not provide the full path, the old storage file is
in a non-default location.

1. In the migrationLog.txt file, determine to which product the message applies.

2. Go to the new_Software AG_directory /profiles/product /configuration/event/
routing/runtime directory.

3. Open the configuration.json file and find the storage-location property.

4. Copy the old storage file to the directory specified on the property.
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Migrate Event Persistence Services
If you used Event Persistence to persist events in the old installation, configure new
services in the new installation.
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Before You Run Migration Utilities
Most products offer migration utilities that automatically migrate configurations and
data from your old installation to your new installation. This section describes the
general behavior of the migration utilities; any exceptions to the general behavior are
noted in the product-specific chapters.

You can run migration utilities as follows:

For some products, migration utilities run without prompting you for any
information (that is, silently). If the utility fails to migrate an item, the utility exits.
The utility does not revert the new product installation. You can address the issue
and rerun the utility.

For other products, you can run migration utilities as follows:

You can run a custom migration, in which you select the configurations and data
to migrate. The utility gathers your seings through a series of prompts, then
migrates the selected configurations and data. You can export your seings to a
file named migrate.dat and use them in other upgrades.

You can run a migration with imported seings and some prompting or
without any prompting (that is, silently). The imported seings can come
from seings you exported from a custom migration, or from the default
migration provided by Software AG with the product installation in a file named
migrateold_release sbs.dat. The seings for default migrations are described in the
product-specific chapters.

If you are running the utility with prompting, and the utility fails to migrate an
item, the utility asks whether to continue with the next item or abort the migration.
If you choose to abort, the utility exits. The utility does not revert the new product
installation. You can address the issue and rerun the utility.

Note: When you run migration utilities, you provide the full path to the old
installation, and sometimes the path to the new installation. If you supplied
a symbolic link as the installation directory when you installed the old or
new product, the path you provide to the migration utility must be the same
symbolic link path you supplied during installation.

Migration utilities write detailed migration information to the command window and
to the migrationLog.txt file in the new_Software AG_directory /install/logs directory.
By default, utilities write INFO, ERROR, and FATAL messages to the log. If you
want to increase the logging level for a product’s migration to DEBUG, go to the
product directory that contains the log4j.properties file (for example, the new_Software
AG_directory /product /bin/migrate or /migrate/bin directory), open the file in a text
editor, set the log4j.logger.Migration property to DEBUG, MigrationFile and save
and close the file.
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Run the Software AG Infrastructure Migration Utility
The Software AG Infrastructure migration utility runs without prompting you for any
information. If an error occurs, the utility exits.

1. On the machine that hosts the new products, open a command window or shell, go
to the new_Software AG_directory /common/migrate/osgi/bin directory, and run the
command below. For the migrateold_release sbs.dat file, specify old_release  without
periods (for example, 980, or 9100).
migrate.{bat|sh} 
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true

2. If you see a Software AG_directory /profiles/CTP directory in both the old and new
installation directories, go to the new_Software AG_directory /profiles/CTP/bin/migrate
directory and run the same command again.

3. Install the latest product fix on the new Common Platform and the new Security
Infrastructure. Fix names for these products typically include the leers OSGI and
SIN, respectively. For instructions on installing fixes, see Using Software AG Update
Manager and the fix readme files.

Run the Universal Messaging Migration Utility

Perform a Custom Migration
1. On the machine that hosts the new Universal Messaging, open a command window

or shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate
directory, and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
Universal Messaging installation or the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter N.

4. The utility asks which Universal Messaging instance to migrate and lists the
instances in the old installation. To specify multiple instances, separate them using
commas.

Upgrade from 9.8 or later: To migrate all instances, press Enter without specifying
any instances.

5. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.

6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.
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Migrate Using Imported Settings
Imported seings can come from the following:

Seings you exported from a custom migration. These seings are stored in a file
named migrate.dat in the new_Software AG_directory /UniversalMessaging/tools/
migrate directory from which you ran the custom migration. Copy the migrate.dat
file to any directory on machines that host new Universal Messaging installations to
which you want to migrate data.

Seings in the default migrations provided with Universal Messaging. For each old
release, the seings are stored in a file named migrateold_release sbs.dat file provided
by Software AG in the new_Software AG_directory /UniversalMessaging/tools/migrate
directory. The seings tell the migration utility to migrate the data listed under “
Universal Messaging Configurations, Data, and Assets that Can be Migrated” on
page 62.

Migrate Using Custom Imported Settings with Prompting
1. On the machine that hosts the new Universal Messaging, open a command window

or shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate
directory, and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
Universal Messaging installation or to the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat file.

Migrate Using Custom Imported Settings without Prompting (Silent)
On the machine that hosts the new Universal Messaging, open a command window or
shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate directory,
and run the command below. If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile full_path_to_ migrate.dat
-silent true

Migrate Using Default Imported Settings without Prompting (Silent)
On the machine that hosts the new Universal Messaging, open a command window or
shell, go to the new_Software AG_directory /UniversalMessaging/tools/migrate directory,
and run the command below. For the migrateold_release sbs.dat file, specify old_release
without periods (for example, 980, or 9100).

The default imported seings migrate all instances, therefore only specify -
instanceName if you want to override that default.

If an error occurs, the utility exits.
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migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile migrateold_release sbs.dat
[-instanceName name [,name ...]]
-silent true

Run the My webMethods Server Migration Utility

Note: Starting in My webMethods Server 10.3, My webMethods Server no longer
offers an embedded database. If the old My webMethods Server used the
embedded database,

Perform a Custom Migration
1. On the machine that hosts the new My webMethods Server, open a command

window or shell, go to the new_Software AG_directory /MWS/bin/migrate directory,
and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
My webMethods Server installation or the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter N.

4. For each instance in the old My webMethods Server installation, the utility asks the
following:

a. Whether to migrate the instance.

b. Whether to use the live database or a cloned database with the migrated instance.
If you respond that you are using a cloned database, the utility prompts for the
database URL, user, and password.

Note: You cannot use a new database that contains no data.

c. If the old instance was connected to Universal Messaging, whether to use the
old Universal Messaging URL or a new URL for the migrated instance. If you
respond that you want to use a new URL, the utility prompts for the URL.

If the old instance was not connected to Universal Messaging, whether to
specify a connection to Universal Messaging now or at some later time. If you
respond that you want to specify the connection now, the utility prompts for the
Universal Messaging URL.

d. Whether to use a new node name for the migrated instance.

5. The utility asks whether to export your seings from this session. If you want to
perform other migrations by importing the seings from this session, enter Y. If not,
enter N.

6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
instances you specified.
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Migrate Using Imported Settings
Imported seings can come from the following:

Seings you exported from a custom migration. These seings are stored in
a file named migrate.dat in the new_Software AG_directory /MWS/bin/migrate
directory. Copy the migrate.dat file to any directory on machines that host new My
webMethods Server installations to which you want to migrate data.

Seings in the default migrations provided by Software AG with My
webMethods Server. For each old release, the seings are stored in a file named
migrateold_release sbs.dat file in the new_Software AG_directory /MWS/bin/migrate
directory. The seings tell the migration utility to migrate all instances within the old
installation to the new installation, and to use the live database.

Migrate Using Custom Imported Settings with Prompting
1. On the machine that hosts the new My webMethods Server, open a command

window or shell, go to the new_Software AG_directory /MWS/bin/migrate directory,
and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the old Software AG installation directory or to
the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat file.

Migrate Using Default Imported Settings without Prompting (Silent)
You can migrate in silent mode when the old and new My webMethods Server
installations are identical (for example, they are hosting the same user interfaces for
other products).

On the machine that hosts the new My webMethods Server, open a command window
or shell, go to the new_Software AG_directory /MWS/bin/migrate directory, and run the
command below. For the migrateold_release sbs.dat file, specify old_release  without
periods (for example, 980, or 9100).

The default imported seings migrate all instances, therefore only specify -
instanceName if you want to override that default.

If an error occurs (for example, the installations are not identical), the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile migrateold_release sbs.dat
[-cloneDbURL URL  -cloneDbUser user  -cloneDbPassword password ]
[-instanceName name [,name ...]]
[-newNodeName instance_name:new_node_name [,instance_name:new_node_name ,...]]
-silent true
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Migrate Using Custom Imported Settings without Prompting (Silent)
You can migrate in silent mode when the old and new My webMethods Server
installations are identical (for example, they are hosting the same user interfaces for
other products).

On the machine that hosts the new My webMethods Server, open a command window
or shell, go to the new_Software AG_directory /MWS/bin/migrate directory, and run the
command below.

If an error occurs (for example, the installations are not identical), the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile full_path_to_ migrate.dat
-silent true

Run the Integration Server Migration Utility
If the old Integration Server installation has multiple server instances, you run the
migration utility once for each instance you want to migrate. You can have the utility
migrate old instances to new instances you created after installation or to new instances
that the utility creates for you.

Perform a Custom Migration
1. On the machine that hosts the new Integration Server, open a command window

or shell and go to the new_Software AG_directory /IntegrationServer/bin/migrate
directory.

2. Run the command migrate.{bat|sh}.

3. The utility asks for the full path to the Software AG directory that contains the old
Integration Server installation or the ZIP file you made earlier.

4. If the old Integration Server installation has more than one server instance, the utility
asks which instance to migrate and lists the instances in the old installation.

The utility then asks for the name of an instance to be the target of the migration. If
you want the utility to migrate to the instance that was created during installation of
the new Integration Server, enter the name of that instance. If you want the utility to
create an instance and migrate to this new instance, enter a name that does not exist
in the new installation.

If Wm packages exist on the old instance, and the same Wm packages exist in the
new package repository, the utility will install those Wm packages from the new
package repository on the new instance. If language packs exist in the package
repository, the utility will install those language packs on the new instance.

5. The utility asks whether to import migration seings. Enter N.
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6. The utility asks whether to migrate custom packages. If you choose to migrate all
custom packages, the utility migrates the following:

Custom packages.

The WmChemPayloads, WmPapinetPayloads, WmRNPips, WmFINMessages,
and WmFIXMessages packages, if present. These packages contains IS
documents for the corresponding eStandards Modules and the schemas for those
documents.

If you choose to migrate selected packages only, the utility lists each of the packages
above and asks whether to migrate it.

7. The utility asks whether to migrate the password store, and whether to migrate
passwords.

8. The utility asks whether to migrate Integration Server configuration files. If you
choose to migrate selected configuration files only, the utility lists each configuration
file and asks whether to migrate it. There are about 50 configuration files.

9. The utility asks you to specify the behavior to use for new properties that have
been added to the new Integration Server and existing properties that have new
defaults in the new Integration Server. If you choose to specify the behavior to use,
the utility lists each property and asks whether to use new behavior or preserve
existing behavior. You can also read about these properties in the Integration Server
readme.

For CloudStreams, select the new behaviour asNeeded for the
wa.server.hp.listRequestVars property.

10. The utility asks whether to migrate functional aliases, database driver
configurations, and JDBC connection pool configurations. If you enter Y for JDBC
connection pool configurations, the utility asks whether to use the live database or
a cloned database with each migrated connection pool. If you respond that you are
using a cloned database for the migrated connection pool, the utility asks for the
database URL, user, and password.

11. If the Integration Server hosts Wm packages, the utility asks whether to migrate
the configuration files for those packages. Examples of hosted Wm packages are
ActiveTransfer (WmMFT), Process Engine (WmPRT), adapters, and eStandards
Modules. For some products, you might see additional prompts for migrating other
data.

12. The utility asks whether to migrate custom jar files. If you choose to migrate selected
custom jar files only, the utility lists each custom jar file and asks whether to migrate
it.

13. If the Integration Server hosts Trading Networks, the utility asks whether to migrate
Trading Networks information. If you enter Y, the utility asks the following:

a. Whether to migrate the Trading Networks configuration file. If you enter Y,
the utility copies the configuration properties from the old Trading Networks
installation directory, adds them to the new configuration properties in the
new Trading Networks, and replaces the properties.cnf file in the new_Software
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AG_directory /IntegrationServer/instances/instance_name /packages/WmTN/config
directory.

b. Whether to migrate Trading Networks data. This migration maps the data in the
Trading Networks database to the new table structure.

Note: If you have a cluster of Trading Networks instances, the data is shared
by all instances, so only migrate the data for one instance.

c. Whether to migrate Trading Networks dashboard data. If you enter
Y, the utility purges records from the dashboard tables and populates
records from BIZDOC tables into dashboard tables. The dashboard
tables include TransactionSummaryData, CustomAributeVolumeValue,
TransactionSuccessFailedData, SuccessFailedChartDocIdMap, and
TransactionLateFAData.

14. The utility asks whether to migrate JAAS configurations.

15. The utility asks whether to migrate Java Service Wrapper customizations you
made in the old custom_wrapper.conf files, if any. These are migrated to the new
custom_wrapper.conf file.

16. The utility asks whether to update the Integration Server host name in your database
tables. If the old and new Integration Servers are on different machines, respond Y.

17. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.

18. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.

Migrate Using Imported Settings
Imported seings can come from the following:

Seings you exported from a custom migration. These seings are stored in a file
named migrate.dat in the new_Software AG_directory /IntegrationServer/bin/migrate
directory from which you ran the custom migration. Copy the migrate.dat file to any
directory on machines that host the new Integration Server installations to which
you want to migrate data.

Seings in the default migrations provided with Integration Server. For each old
release, the seings are stored in a file named migrateold_release sbs.dat file provided
by Software AG in the new_Software AG_directory /IntegrationServer/bin/migrate
directory. The seings tell the migration utility to migrate the data listed under “Run
the Integration Server Migration Utility” on page 133. For Integration Server
properties that are new or that have new defaults, the default migration chooses the
behavior that best preserves backwards compatibility.
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Migrate Using Custom or Default Imported Settings with Prompting
1. On the machine that hosts the new Integration Server, open a command window or

shell, go to the new_Software AG_directory /IntegrationServer/bin/migrate directory,
and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
Integration Server installation or to the ZIP file you made earlier.

3. If the old Integration Server installation has more than one server instance, the utility
lists the instances and asks which instance to migrate from.

4. The utility asks for the name of a new server instance to be the target of the
migration. See this step in “Perform a Custom Migration” on page 133 for
detailed information on what to enter and how the utility proceeds.

5. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat file or the migrateold_release sbs.dat file. For
the migrateold_release sbs.dat file, specify old_release  without periods (for example,
980, or 9100).

Migrate Using Custom or Default Imported Settings without Prompting (Silent)
If you are using a cloned database for Integration Server database components, specify
the -cloneDb options on the command as shown below. The migration utility uses the
cloneDb options only for the Integration Server database components. If you are using a
cloned database for the database components of hosted products (for example, Trading
Networks), perform a custom migration that identifies the cloned database, then run the
command below with the migrate.dat file created by the custom migration.

On the machine that hosts the new Integration Server, open a command window or
shell, go to the new_Software AG_directory /IntegrationServer/bin/migrate directory, and
run the command below. For the migrateold_release sbs.dat file, specify the source release
number without periods (for example, 980).

If you want to specify a new name for the migrated instance, specify -newInstanceName.

If the new and old Integration Servers are on different machines, and you want the
utility to update the Integration Server host name in your database tables, specify -
oldHostName and -newHostName.

If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Integration Server_directory|ZIP_file}
-importFile {migrateold_release sbs.dat|full_path_to_ migrate.dat}
-instanceName name  [-newInstanceName name ]
[-cloneDbURL URL  -cloneDbUser user  -cloneDbPassword password ]
-silent true



M
Odd Header

Migrate Products Using Migration Utilities

Upgrading Software AG Products Version 10.3 137

Run the Infrastructure Data Collector Migration Utility

Perform a Custom Migration
1. On the machine that hosts the new Infrastructure Data Collector, open a command

window or shell, go to the new_Software AG_directory /Infrastructuredc/bin/migrate
directory and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
Infrastructure Data Collector installation or the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter N.

4. The utility asks whether to migrate SNMP asset configuration files. If you
respond Y, the migration utility will migrate the old files you identified in the
snmpMigration.properties file.

5. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.

6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.

If you chose to migrate asset configuration files, and a file that has the same name
as an old file already exists in the new Infrastructure Data Collector installation,
the utility backs up the new file to the new_Software AG_directory /infrastructuredc/
migrationbackup directory before migrating the old file. The same is true for all
migrated directories and files.

Migrate Using Imported Settings
Imported seings can come from the following:

Seings you exported from a custom migration. These seings are stored in a file
named migrate.dat in the new_Software AG_directory /infrastructuredc/bin/migrate
directory from which you ran the custom migration. Copy the migrate.dat file to any
directory on machines that host new Infrastructure Data Collector installations to
which you want to migrate data.

Seings in the default migrations provided with Infrastructure Data Collector. For
each old release, the seings are stored in a file named migrateold_release sbs.dat
file in the new_Software AG_directory /infrastructuredc/bin/migrate directory. The
seings tell the migration utility to migrate the configurations, data, and assets listed
in “ Infrastructure Data Collector Configurations, Data, and Assets that Can be
Migrated” on page 89.
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Migrate Using Custom or Default Imported Settings with Prompting
1. On the machine that hosts the new Infrastructure Data Collector, open a command

window or shell, go to the new_Software AG_directory /infrastructuredc/bin/migrate
directory, and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
Infrastructure Data Collector installation or to the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat file or the migrateold_release sbs.dat file. For
the migrateold_release sbs.dat file, specify old_release  without periods (for example,
980, or 9100).

Migrate Using Custom or Default Imported Settings without Prompting
On the machine that hosts the new Infrastructure Data Collector, open a command
window or shell, go to the new_Software AG_directory /infrastructuredc/bin/migrate
directory, and run the command below. For the migrateold_release sbs.dat file, specify the
source release number without periods (for example, 980).

If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory |ZIP file}
-importFile {migrateold_release sbs.dat|full_path_to_ migrate.dat}
-silent true

Run the Application Platform Migration Utility
The Application Platform migration utility runs without prompting you for any
information. If an error occurs, the utility exits.

On each machine that hosts a new Integration Server instance that hosts the Application
Platform Support package or a new My webMethods Server that hosts Application
Platform projects bundles, open a command window or shell, go to the new_Software
AG_directory /common/migrate/AppPlatform/bin directory, and run the command
below. For the migrateold_release sbs.dat file, specify old_release  without periods (for
example, 980, or 9100).
migrate.{bat|sh} 
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true



M
Odd Header

Migrate Products Using Migration Utilities

Upgrading Software AG Products Version 10.3 139

Run the MashZone NextGen Migration Utility

Perform a Custom Migration
1. On the machine that hosts the new MashZone NextGen, open a command window

or shell, go to the new_Software AG_directory /MashZoneNG/prestocli/bin/migrate
directory and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
MashZone NextGen installation or the ZIP file you made earlier.

3. The utility asks whether to import migration seings. Enter N.

4. The utility asks whether to migrate the configurations, data, and assets listed
in “ Infrastructure Data Collector Configurations, Data, and Assets that Can be
Migrated” on page 89.

5. The utility asks whether to export your seings. If you want to perform other
migrations by importing the seings from this session, enter Y. If not, enter N.

6. The utility asks whether to begin migration. If you enter Y, the utility migrates the
data you selected.

Migrate Using Imported Settings
Imported seings can come from the following:

Seings you exported from a custom migration. These seings are stored in a file
named migrate.dat in the new_Software AG_directory /MashZoneNG/prestocli//bin/
migrate directory from which you ran the custom migration. Copy the migrate.dat
file to any directory on machines that host new MashZone NextGen installations to
which you want to migrate data.

Seings in the default migrations provided with MashZone NextGen. For each old
release, the seings are stored in a file named migrateold_release sbs.dat file provided
by Software AG in the new_Software AG_directory /MashZoneNG/prestocli/bin/
migrate directory. The seings tell the migration utility to migrate the data listed
under “ MashZone NextGen Configurations, Data, and Assets that Can be Migrated”
on page 108.

Migrate Using Custom Imported Settings with Prompting
1. On the machine that hosts the new MashZone NextGen, open a command window

or shell, go to the new_Software AG_directory /MashZoneNG/prestocli/bin/migrate
directory, and run the command migrate.{bat|sh}.

2. The utility asks for the full path to the Software AG directory that contains the old
MashZone NextGen installation or to the ZIP file you made earlier.
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3. The utility asks whether to import migration seings. Enter Y and, when prompted,
provide the full path to the migrate.dat file file.

Migrate Using Custom or Default Imported Settings without Prompting (Silent)
On the machine that hosts the new MashZone NextGen, open a command window or
shell, go to the new_Software AG_directory /MashZoneNG/prestocli/bin/migrate directory,
and run the command below. For the migrateold_release sbs.dat file, specify old_release
without periods (for example,1010, or 1020).

If an error occurs, the utility exits.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile {migrateold_release sbs.dat|full_path_to_ migrate.dat}
-silent true

Run the OneData Migration Utility
The OneData migration utility runs without prompting you for any information. If an
error occurs, the utility exits.

On the machine that hosts the new OneData, open a command window or shell, go
to the new_Software AG_directory /profiles/ODE/bin/migrate directory, and run the
command below.
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-silent true

Before migrating data, the utility backs up the files that contain the new configuration
data in the new_Software AG_directory /profiles/ODE/bin/onedata/config directory. The
backup files have the extension .bck.

Run the Digital Event Services Migration Utility
The Digital Event Services migration utility runs without prompting you for any
information. If an error occurs, the utility exits.

On the machine that hosts the new products, open a command window or shell, go to
the new_Software AG_directory /common/migrate/DigitalEventServices/bin directory,
and run the command below. For the migrateold_release sbs.dat file, specify old_release
without periods (for example, 9120).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true
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Run the Event Routing Migration Utility
The migration utility runs without prompting you for any information. If an error
occurs, the utility exits.

On the machine that hosts the new products, open a command window or shell, go
to the new_Software AG_directory /common/migrate/EDA/bin directory, and run the
command below. For the migrateold_release sbs.dat file, specify old_release  without
periods (for example, 980, or 9100).
migrate.{bat|sh}
{-srcDir|-srcFile} full_path_to_{old_Software AG_directory|ZIP_file}
-importFile migrateold_release sbs.dat
-silent true
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Configure your new products. For instructions, see the product documentation for
the new release.

If you installed your new products on a different machine than your old products,
make sure to update host names in your new products, in the connections between
your products, and in your database tables. This guide indicates many locations
in which to update host names, but make sure you also specify the correct host
names when you configure your new products using the instructions in the product
documentation. Also make sure any absolute paths in the new configuration files
point to valid locations, or change them to be correct for the new machine. If the
machine has a different operating system or hardware, make sure your JVM seings
are correct.

Read the product readmes for the new release, including the readme for the Software
AG Infrastructure. All readmes are available on the Software AG Documentation
website. The product readmes contain this information:

Critical information and known and resolved issues for your products.

Changes to product behavior, services, parameters, properties, and APIs. Such
changes can include additions, changes, deprecations, and removals. This
information is especially important because you might need to modify product
files or assets after migration to accommodate the changes.

Read the information in product readmes for your old release+1 through the new
release. For example, if you are upgrading from 9.8 to 10.3, read the information for
releases 9.9 through 10.3.

After installation, you might have set Windows services for products to Manual, and
disabled scripts that start UNIX daemons, to avoid automatically starting both old
and new products. When your new environment is ready, after you stop running the
old products and when you want to start running the new ones, you can reset the
Windows services to Automatic, and re-enable the UNIX scripts.

After you have thoroughly tested your new environment, you can reclaim disk space
by deleting ZIP files and files extracted from ZIP files from new machines, or by
uninstalling products from old machines. To uninstall old products, use Command
Central or the Software AG Uninstaller for the old release.
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